Information in this document is subject to change without notice and does not represent a commitment on the part of Technical Difference, Inc. The software product described in this document is furnished under a license agreement or nondisclosure agreement. The software and this documentation may be used or copied only in accordance with the terms of that agreement.

All names of companies, products, street addresses, and persons are part of a completely fictitious scenario and are designed solely to document the use of People-Trak. Similarities to real companies, products, addresses, or persons are purely coincidental.

People-Trak is an extensively customizable HR software product. Screen and report samples rendered in this document reflect the default version of People-Trak. These samples may or may not match the screens and reports within your product if customization has been performed.

(C) Copyright Technical Difference, Inc., 2014

Technical Difference, Inc.
5256 S. Mission Road #210
Bonsall, CA 92003
(800) 273-3760
(866) 693-4869 (fax)

www.people-trak.com

(Revision 01/01/2014)
# Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Conventions</td>
<td>1</td>
</tr>
<tr>
<td>Application Conventions</td>
<td>5</td>
</tr>
<tr>
<td>Application Components</td>
<td>5</td>
</tr>
<tr>
<td>Application Terms</td>
<td>13</td>
</tr>
<tr>
<td>Getting Started</td>
<td>15</td>
</tr>
<tr>
<td>User Types</td>
<td>15</td>
</tr>
<tr>
<td>Starting People-Trak</td>
<td>15</td>
</tr>
<tr>
<td>People-Trak Desktop</td>
<td>16</td>
</tr>
<tr>
<td>Modules</td>
<td>16</td>
</tr>
<tr>
<td>Workflows</td>
<td>16</td>
</tr>
<tr>
<td>Working with Records</td>
<td>17</td>
</tr>
<tr>
<td>Working with Companies</td>
<td>17</td>
</tr>
<tr>
<td>Logging Off</td>
<td>17</td>
</tr>
<tr>
<td>Organizer Desktop</td>
<td>19</td>
</tr>
<tr>
<td>People-Trak Bar</td>
<td>19</td>
</tr>
<tr>
<td>Header</td>
<td>19</td>
</tr>
<tr>
<td>Desktop Bar</td>
<td>19</td>
</tr>
<tr>
<td>Main Menu Bar</td>
<td>20</td>
</tr>
<tr>
<td>Shortcut Bar</td>
<td>22</td>
</tr>
<tr>
<td>Modules Pane</td>
<td>22</td>
</tr>
<tr>
<td>Categories Pane</td>
<td>22</td>
</tr>
<tr>
<td>Tasks Pane</td>
<td>22</td>
</tr>
<tr>
<td>People-Trak News Pane</td>
<td>23</td>
</tr>
<tr>
<td>Status Bar</td>
<td>23</td>
</tr>
<tr>
<td>Workflow Area</td>
<td>25</td>
</tr>
<tr>
<td>Title Bar</td>
<td>25</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>25</td>
</tr>
<tr>
<td>Tool Bar</td>
<td>27</td>
</tr>
<tr>
<td>Navigation Bar</td>
<td>27</td>
</tr>
<tr>
<td>Category Bar</td>
<td>28</td>
</tr>
<tr>
<td>Primary Screen Area</td>
<td>29</td>
</tr>
<tr>
<td>Operating Conventions</td>
<td>31</td>
</tr>
<tr>
<td>Data Validation</td>
<td>31</td>
</tr>
<tr>
<td>Required Fields</td>
<td>31</td>
</tr>
<tr>
<td>Formatting</td>
<td>32</td>
</tr>
<tr>
<td>Cut, Copy, and Paste</td>
<td>32</td>
</tr>
<tr>
<td>Date Stamp</td>
<td>33</td>
</tr>
<tr>
<td>Exiting a Record or Screen</td>
<td>33</td>
</tr>
<tr>
<td>Enable Preselect</td>
<td>34</td>
</tr>
<tr>
<td>Color Conventions</td>
<td>34</td>
</tr>
<tr>
<td>Using the Undo Feature</td>
<td>35</td>
</tr>
<tr>
<td>Working with Grids</td>
<td>36</td>
</tr>
<tr>
<td>Field Types</td>
<td>37</td>
</tr>
</tbody>
</table>
Popups 40  
Key Functions 48  
File Menu Functions 50  

**Desktop Setup** 53  
Overview 53  
Desktop Setup Screen 53  

**User Setup** 57  
Multi-User Environment 57  
User Types 57  
Key User Settings and Procedures 57  
User Setup Screen 59  

**Lesson 1 Desktop Setup** 65  
Tutorial 1.1 – Specifying Login Settings 66  
Tutorial 1.2 – Specifying Default Desktop Settings 68  
Tutorial 1.3 – Specifying Logos and Header Settings 71  
Tutorial 1.4 – Organizer Tab 74  
Tutorial 1.5 – Specifying Default Desktop Tasks 75  

**Lesson 2 User Setup** 79  
Tutorial 2.1 – Adding/Deleting Users 80  
Tutorial 2.2 – Setting User Preferences 82  
Tutorial 2.3 – Changing Default Settings at the User Level 84  
Tutorial 2.4 – Changing Standard Workflows 86
The standard writing conventions used in this document and all training guides are described below.

**Numbered Action Steps**
All actions steps are numbered. Any informational text is not. This allows you to easily see when actions are required.

**Using Bold Print**
In action steps, when referring to screens, character input, buttons, check boxes, menus, menu options, tab names, field names and key names, bold print is used, as shown below.

*On the Personnel screen*
*Enter N*
*Click OK*
*On the File menu, select Open Employee*
*On the Options tab*
*In the City field, enter Bonsall.*

**Entering Information**
When an instruction involving a typed response is given, the standard formats shown below are used.

*Enter the employee number.*
*Enter N.*

The phrase "enter" indicates that a letter or phrase is to be typed on the keyboard. If specific characters are to be typed, they will be in bold print, as is the “N”

**Entering Large Amounts of Text**
When directing you to enter a large amount of text, the text to be entered will be on lines by itself and will be in bold print.

**Messages and Examples**
When referring to a message that is displayed or giving an example, the message/example will be on a line by itself and will be in the Arial font.

**Placeholders**
When placeholders are needed within data entry, italics will be used, as shown below.

Today’s date

**Field Inserts**
When field inserts are needed within a template, the standard format shown below is used. In this example, you are to type the word “Dear”, followed by a space, and then use the Insert Field option to insert the employee First Name, and then follow the insert with a comma.

*Dear ~F~ (insert employee First Name),*
Pressing Keys
When an instruction involving a key on the keyboard is issued, the standard format shown below is used.

Press **ENTER**.
Press **DOWN ARROW**.

The phrase "press" indicates that a key on the keyboard is to be pressed down. The key name (ENTER and DOWN ARROW in the examples) is in bold print, written out and capitalized.

If a combination of keys is required, the following format is used:

Press **CTRL + X**.

This means that you need to press and hold down the CTRL key while pressing the X key.

The key names used in all instructions are generic and may differ slightly from the keys on your keyboard. For example, your ENTER key may be labeled RETURN or NEWLINE.

Check Boxes
A check box is a square box that is selected or cleared to turn on or off an option. The term “check box” will always follow the check box name. The word “Select” indicates that you are to turn the option on. The word “Clear” indicates that you are to turn the option off. See the examples below.

*Select the **Active** check box.*
*Clear the **Active** check box.*

Option Buttons
An option button is a round button used to select one of a group of mutually exclusive options. The phrase “click” is used to describe selecting the option.

*Click **Portrait**.*

Dropdown
A dropdown button is available on a field that has a list of options associated with it. When you click on the dropdown button, a box is dropped down below the field with the list of options. The name of the field and the phrase “dropdown” are used when referring to a specific dropdown, as shown below.

*In the **Record** dropdown*
Program/Process
People-Trak is referred to as a “program” and each of the executable menu options within People-Trak is referred to as a “process” throughout all documentation.

Screen/Subscreen
Any window in People-Trak is referred to as a “screen” throughout all documentation. There are primary screens, sub screens called by primary screens using buttons, and popup screens called from fields using buttons. When referring to any type of screen, the title of the screen is used, as shown below.

On the Personal screen
On the Lookup screen

The Phrase “Display”
The phrase “display” is used as a verb to describe the appearance of menus, prompts, screens, reports, and messages. Examples are shown below.

The Personal screen is displayed.
The following message is displayed.

The Phrase “Print”
The phrase “print” is used as a verb to describe the appearance of reports on the printer. Examples are shown below.

When the report has printed ...
This option is used to print the ...

The Phrase “Click”
The phrase “click” is used as a verb to describe the process of pressing and immediately releasing the mouse button without actually moving the mouse.

Click the Run button.
Click the Settings tab.

The Phrase “Double-Click”
The phrase “double-click” is used as a verb to describe the process of pressing and immediately releasing the mouse button two consecutive times without actually moving the mouse.

Double-click the desired item.

The Phrase “Drag”
The phrase "drag" is used as a verb to describe the process of pointing to an item and moving the mouse while holding the mouse button down, thereby moving the item to another location.

Drag the file to the Trash Can icon.
The Phrase “Select”

The phrase "select" is used as a verb to describe the process of choosing a menu option, a dropdown item, a table item or any item in a list. It assumes you have clicked or double-clicked as necessary to have the item selected. In the case of a table item in a popup, it assumes that the OK button has been clicked to close the popup screen and complete the selection.

On the Documents menu, select Adhoc Reports.  
In the Screen dropdown, select the Status screen.  
In the City field, click the popup button and select Bonsall.
Application Conventions

The standard application components and terms used in this document and all training guides are described below.

Application Components

An application is composed of various types of components that can be used and described independently. The most prominent ones (those that you will use with People-Trak) are described below.

Button

A button triggers an event to which an application responds. Buttons come in various shapes and sizes. When buttons are used on a Tool Bar (see Tool Bar section), they normally have a graphical icon. The icon is not required and buttons used in other locations frequently use text only. Some text-based buttons contain a letter that is underlined. The underlined character is used with the ALT key to perform key-based activation of the button. A sample button is shown below.

This button can be “pressed” with a mouse click or by pressing the ALT key and the “O” key at the same time. If a button does not have an underlined letter, the ALT key technique cannot be used.

Category Bar

The Category Bar is used to navigate among screens and category buttons available in the current module. A sample Category Bar is shown below.

Check Box

A check box is used to display and capture information that is either true or false. For example, a check box is used to capture the active status of an employee in the screen excerpt shown below.

If the check box is selected, the employee is active. If the check box is not selected, the employee is inactive. Check boxes can be toggled between the two states using the mouse to click on the box. A check box can also be toggled using the SPACEBAR.

Dropdown

This refers to a list box (see list box below) that is normally stored in a “rolled up” position, but drops down when you click on the arrow button. Dropdowns are normally used on Tool Bars, but can be used anywhere on a screen. A sample dropdown is shown below.
When a dropdown has been dropped down, it can be rolled back up by making a selection or by clicking elsewhere on the screen to transfer focus to another component. When a dropdown loses the focus, it automatically rolls up.

**Frame**

A frame is used to group other components into a collection of related information. In the screen excerpt shown below, note how the Demographics frame collects the demographic information into a group and makes the screen more readable and thus more usable.

A frame may utilize an optional caption to provide a description of the information that has been grouped within the frame.

**Grid**

A grid is an array or matrix of information displayed in rows and columns. A sample screen excerpt with a grid component is shown below.
Normally the grid has “gridlines” to assist in defining the rows and columns. Some grids are editable and some are not. When a grid is editable, a text box or check box moves around on the grid to capture input. Grids scroll vertically when there are more rows that can fit in the available space.

**Heading**

A heading is a block of text used to label and delineate a given area on the screen. Headings can have a background color with lighter text or can be a block of dark text. The sample screen below displays the four different headings available.

**HTMLLabel**

HTMLLabels use the rich text formatting capabilities of HTML to provide for a wide range of font sizes, colors, and text arrangement. The HTMLLabel on the screen below is used to provide instructions.
Hyperlink
A hyperlink is a short text phrase that is associated with some type of trigger action. Normally, a hyperlink is used to launch a URL or a web page. In People-Trak, the full capabilities of button triggers can be associated with a hyperlink, which includes a URL, but can also run reports, send email, etc. The previous screen displays a hyperlink for users to access the People-Trak website.

Image
A photograph or other type of graphical image which has been stored in the product as part of a record. For example: an employee photo which is attached to an employee record and is then displayed when the record is recalled is an image.

Label
A label displays textual information in a single font and in a single color. In addition, no other formatting such as enumeration or bulleted can be performed. The label on the screen below is used to provide instructions.

Line
A line is a vertical or horizontal element used to delineate or define areas on a screen. The sample screen below displays a variety of lines.
List Box

A list box is used to present a list of related information. Most list boxes are a single column and display multiple rows of information. Some list boxes contain multiple columns as well and are essentially grids without the grid lines. List boxes are often used with a dropdown. When the dropdown button is pressed, the list box rolls down and you can make a selection from the list. When you make a selection or move the focus from the list box, the list box rolls back up.

Menu

A menu is a software component that organizes options and activities for selection. This component is called a menu because the selections are listed much like the entrees in a restaurant. A sample main menu that is displayed horizontally across the screen is shown in the excerpt below.

The submenus drop down from the menus on the main menu as shown below.
Application Conventions

Additional menus are often displayed when one of the menu options on the dropped down menu is displayed.

Most menu items contain a letter that is underlined. The underlined character is used with the ALT key to perform key-based pressing of the button. A menu item can be selected with the click of a mouse or by pressing the ALT key sequence using the underlined character.

**Navigation Bar**
The Navigation Bar contains features used to navigate among the records that have been selected for editing. A sample Navigation Bar is shown below.

![Navigation Bar](image)

**Picture**
A photograph or other type of graphical image that has been placed on a screen as a permanent part of the screen. It does not change when the data on the screen changes. For example: if an employee photo is used as an image on a screen that also has a picture of a cat, the picture of the cat remains on the screen even if you move between other employees causing the employee photo to change.

Pictures can be associated with button triggers and can thus be used to display screens, run reports, send email, etc. For example, two pictures can be added to a screen: a left arrow and a right arrow. You can then assign the respective triggers to the buttons to move left or right through a sequence of screens or records.

**Popups**
Popups are screens that pop up when a button is clicked. They return a value for entry into a field or group of fields. A sample font popup is shown below.

![Font Popup](image)

There are many other types of popup screens including dates, time, colors, and directory paths.
Screen
A screen is essentially a window. It contains other components such as labels, check boxes, frames, grids, buttons and text boxes in an organized collection to either present or collect information. A sample screen is shown below. Note the use of the various components.

Shortcut Bar
A Shortcut Bar is a collection of shortcut icons used to quickly access key features. A sample Shortcut Bar is shown below:
**Text Box**

A text box is the most widely used component. It is used to capture text and numbers. The size of the text box normally determines the amount of text that can be captured. Text boxes can have other attributes such as formatting, maximum length, and case (upper, lower, proper, or none). The frame shown below includes a variety of text boxes.

**Treeview**

A treeview is essentially a specialized listbox. Besides providing a list of items to select, it organizes the list into levels, just like chapters, sections, and topics within a book. Each level or node is denoted by a "+" which can be used to expand the items in the node for subsequent selection. When a node is expanded the "+" is switched to a "-" and when the "-" is selected, the node is compressed back down and the "-" changed back to a "+".

Tree views are also used for looking at folder structures on disk drive. Each node represents a level of folders. As you open folders (nodes) you are able to see deeper levels of the folder structure. A tree view is utilized in the Tasks pane, as shown below.

**Tool Bar**

A Tool Bar is a collection of buttons used to perform various functions. Tool Bars are normally horizontal, but this is not always true. A sample horizontal Tool Bar is shown below.
Application Terms

The following are key People-Trak terms, in alphabetical order.

**Company**
A People-Trak enterprise (see definition below) can have multiple companies. People-Trak comes with two pre-defined companies: ACTIVE and ARCHIVE in both the Live enterprise and Demo enterprise. You can also define additional companies. Each company has its own records, and records can be transferred between companies.

**Database**
A database is simply a place where information is stored. The information is arranged into tables where information such as employee, applicant and position data can be placed. The primary storage components within a database are tables. Each table is composed of rows (also known as records) and columns (also known as fields). A record is a collection of fields that comprise a set of related data such as the Address, City, State and Zip Code fields for an applicant. A field is the item or individual piece of information within the record within a table such as a Last Name, First Name, or City.

The first table uses generic terms to show data organization.

<table>
<thead>
<tr>
<th>Row 1</th>
<th>Column 1</th>
<th>Column 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row 1</td>
<td>Row 1, Column 1</td>
<td>Row 1, Column 2</td>
</tr>
<tr>
<td>Row 2</td>
<td>Row 2, Column 1</td>
<td>Row 2, Column 2</td>
</tr>
</tbody>
</table>

The second table uses field and record terms to show data organization.

<table>
<thead>
<tr>
<th>Record 1</th>
<th>Field 1</th>
<th>Field 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record 1</td>
<td>Record 1, Field 1</td>
<td>Record 1, Field 2</td>
</tr>
<tr>
<td>Record 2</td>
<td>Record 2, Field 1</td>
<td>Record 2, Field 2</td>
</tr>
</tbody>
</table>

The third table shows how data is organized for each employee.

<table>
<thead>
<tr>
<th>Employee 1</th>
<th>Last Name</th>
<th>First Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee 1</td>
<td>Employee 1, Last Name</td>
<td>Employee 1, First Name</td>
</tr>
<tr>
<td>Employee 2</td>
<td>Employee 2, Last Name</td>
<td>Employee 2, First Name</td>
</tr>
</tbody>
</table>

**Desktop**
A desktop is essentially a view into People-Trak. There are four different types of desktops available:

- Organizer
- Home Page 1
- Home Page 2
- Home Page 3

**Enterprise**
A People-Trak enterprise is one discrete implementation of People-Trak. A typical installation of People-Trak will include one Live enterprise and one Demo enterprise. In training classes, you are working in the Demo enterprise. Each enterprise can have multiple companies.
**Event**

An event is something that happens that causes an action to be taken. For example, clicking on a field or button, pressing a key, or dragging an item is considered an event. Program code and triggers can be associated with events so that things can happen when you want them. For example, clicking on a field positions the cursor to that field, while clicking on a button launches the program code or trigger associated with that button.

**Module**

A module is a self-contained component of a software program. People-Trak has several modules (Personnel Management, Safety Management, etc.) that are used to capture and process data. These modules interact with one another to provide a complete Human Resources Information System.

**Trigger**

In People-Trak, triggers contain actions that are executed or "triggered" based on certain events. In People-Trak there are six types of defined triggers:

- Alert Triggers
- Approval Triggers
- Button Triggers
- Field Change Triggers
- Record Save Triggers
- Scheduled Triggers

**Workflow**

A Workflow is a collection of one or more screens. People-Trak includes a standard workflow for each module that is used to collect the information required. If the Strategic Toolkit option is implemented, you can also create your own workflows.
Getting Started

User Types

The user type is assigned to a People-Trak user in User Setup and determines what People-Trak desktop and functionality is available to that user.

People-Trak supports the following user types:

- HR - HR User
- Employee - Employee Self-Service User (ESS)
- Manager - Manager Self-Service User (MSS)
- Ex-Employee- Ex Employee Self Service User (Ex-e)
- Applicant –Career Center User (CC)
- Visitor - Visitor User

The HR user type is the only one available in the base People-Trak Essential HR product. The Employee, Manager, and Ex-Employee user types are added when Self Service Employee/Manager has been implemented. The Applicant and Visitors are added with the implementation of Self Service Recruiting.

Starting People-Trak

People-Trak can be started by selecting the People-Trak icon from your desktop or from the Start menu. The People-Trak Login screen is displayed.

Entering Your User ID/Password

Access to People-Trak is granted using a User ID/Password combination. The User ID and Password is assigned in different ways based on the user type. The HR user type is assigned using User Setup.

To access People-Trak, enter your user ID and password into the respective fields on the People-Trak Login screen. Note that the actual password characters are not displayed. When a correct combination is entered, access is granted to People-Trak and the next screen is displayed. If an incorrect combination is entered, you will receive an error message and you must try again. If you enter your password incorrectly three times, People-Trak closes and you will have to start over by reopening People-Trak. If you forget your password, you have the option of clicking the “Forgot your password” link. You will be asked your forgotten password question and you must give the correct answer to have your password emailed to you. You define that question and answer in User Setup on the Login tab.

Based on settings in Enterprise Setup, you will be periodically required to change your password. The Change Password screen will display when it is time for you to change your password:

You would then enter the required information and click Submit to change your password. If you do not submit a change, you will have a number of grace logins (set in Enterprise Setup) before you are shut out of People-Trak completely. If that happens, you must contact the HR Administrator to get your login reactivated.
People-Trak Desktop

When access has been granted to People-Trak, the People-Trak Organizer desktop is displayed. The People-Trak Organizer desktop is highly customizable by company and by user. This desktop is only available to HR users and is the default desktop within Essential HR. From this desktop, it is possible to switch between modules and run processes in a variety of ways. The Tasks pane allows the user to quickly access frequently-used tasks. The People-Trak News pane includes links to the latest information provided by People-Trak.

Modules

A module is a self-contained component of a software program. People-Trak has up to twelve different modules that make up its HR Information System. They are:

- Personnel Management
- Safety Management
- COBRA Administration
- Benefit Administration
- Training Course (optional)
- Training Administration (optional)
- Position Control (optional)
- Requisition Tracking (optional)
- Applicant Management (optional)
- Contact Management
- Generic Module (optional)
- Document Management (optional)

The Position Control, Requisition Tracking and Applicant Management modules are added as part of the Position Control option. The Training Course and Training Administration modules are added as a part of the Training Administration option. The Generic and Document Management modules are added as part of the Strategic Toolkit option.

Selecting a Module

In the Organizer desktop, you can easily select a module by clicking on the appropriate module name in the Modules pane. You can only select a module to which you have been given access, which is controlled in the Security Setup process. When you select a module, the following changes take place:

- The Main Menu Bar includes the options for the selected module.
- The Shortcut Bar includes options for the selected module.

Workflows

A workflow is a collection of one or more screens. People-Trak includes a standard workflow for each module that is used to collect the information required. The name of the standard workflow for a module is “Standard - ” followed by the record maintained by the module. For example, the Personnel Management module maintains the Employee record, so the standard workflow is “Standard - Employee”.

When you create a new record or open an existing one, the default workflow for that module is opened. The workflow screen replaces the processing area of the desktop.
You can change the standard workflow for a module per user using User Setup. You can remove screens and change the order of the screens in the standard workflow.

**Working with Records**

In the Organizer desktop, once you have selected a module, you can work with the records associated with that module, based on your access as determined in Security Setup. For example, if you have selected the Personnel Management module, you can then create, open, delete, transfer or copy an employee record. If you have selected Safety Management, you can create, open, delete, transfer or copy an incident record.

**Working with Companies**

People-Trak is a multi-company product. By default, the product comes with two pre-defined companies: ACTIVE and ARCHIVE. You can use these two companies in any way that you wish, but they are actually designed to contain your active company information and your archived company information. You can create and utilize other companies as well.

Regardless of how many companies you actually have, the operating conventions for working with these companies remain the same. These are described below.

**Changing the Default Company**

Each user is assigned a “default” company. This is the company you are attached to when you first log in. The Default Company is initially set with the User Setup process when the user is created. You can change the default company at any time to any other company to which you have access.

**Note:** If you are assigned to a default company and are then denied access to that company at a later time, you cannot attach to that company at login.

**Controlling Access to Companies**

Access to the standard two companies or to any of the companies that have been defined is controlled with the Security Setup option on the Setup menu.

**Identifying the Current Company**

You can identify the company to which you are currently attached by looking at the company name in the header of the desktop, if the company header is being used.

**Logging Off**

In the Organizer desktop, you can simply click the Logoff shortcut or select the Logoff option on the File menu. Either way, you will be logged off as the current user and the People-Trak Login screen will appear. You then have the option of entering a User ID/Password to log back into People-Trak or clicking Cancel to exit People-Trak.
Notes
The Organizer desktop allows the user to switch between modules and run processes in a variety of ways. The Organizer desktop is only available to HR users. The following is a sample of an Organizer desktop with its components labeled.

The following sections describe each component of the Organizer desktop.

**People-Trak Bar**

The People-Trak Bar is displayed at the very top of the Organizer desktop. It contains the People-Trak name on the left, and Minimize and Close buttons on the right.

**Header**

The Header is located below the People-Trak Bar. This area will include either the enterprise or company name and image as specified in Desktop Setup.

**Desktop Bar**

The Desktop Bar is located below the Header. It includes the name of the current desktop.
Main Menu Bar

The Main Menu Bar is displayed below the Desktop Bar. It contains a phrase for each of the People-Trak menus. When the mouse is clicked on one of these phrases, the corresponding menu is displayed. Each of the menus listed on the Main Menu Bar is described in detail below.

File Menu
The File menu contains options for creating, changing, and deleting records (employees, applicants, COBRA recipients, etc.) and performing other tasks related to records stored within the current module.

When you see the Record placeholder in the descriptions below, this refers to the primary item being tracked by the module. On the actual menus, the Record placeholder will be replaced with the appropriate name. For example, for employee records tracked in the Personnel Management module, the menu phrases will be “New Employee”, “Open Employee”, etc. A similar, appropriate phrase applies to each module.

New Record
Open Record
Select Company
Logoff User

Documents Menu
The Documents menu contains a list of document types.

When you select a document type option, the Explorer is displayed for that type. You can then create, update or run documents.

Templates Menu
The Templates menu contains a list of template types.

When you select a template type option, the appropriate template screen is displayed. You can then create, update or edit templates.

Workflows Menu
If you have workflows defined for the current module that are to be shown on the menu, the Workflows menu is displayed on the Main Menu Bar. The Workflows menu contains workflows that have the Show on Menu check box selected.

Activities Menu
The Activities menu is displayed on the Main Menu Bar and contains the activities available in the current module.

All modules have a standard Manager activity for their respective records. For example, in the Personnel Management module, there is an Employee Manager activity, in the Safety Management module, there is an Incident Manager, and so on. These activities allow you to update records in a module using a more process-oriented approach. These activities also provide non-HR users (such as managers when Self Service Employee/Manager is implemented) a more user-friendly interface for updating records. In Module Setup, you define the lookup and result fields to use for the record Manager activity as well as specify the default source for create.
Processing Menu
If Processing options exist for the current module, the Processing menu is displayed on the Main Menu Bar and contains those options.

Tools Menu
The Tools menu in the base People-Trak Essential HR product contains options for maintaining tables, changing passwords, setting alarms, as well as using productivity tools such as the alert triggers, schedule triggers, and the inbox. Menu options are listed below:

- Inbox
- Maintain Tables
- Set Alarm
- Change Password
- Alert Triggers
- Schedule Triggers

Note: Only users with Administrator access (Administrator check box selected in Security Setup) have access to the complete Tools menu. Non-Administrator users only have access to the Inbox, Maintain Tables, Set Alarm and Change Password options on the Tools menu.

Administration Menu
This menu contains options for performing a wide variety of administration tasks. Menu options are listed below:

- Screen/Field Customization
- System Templates
- Email Attachments
- Email Definitions
- Audit Reports
- Audit/Transaction History
- Database Manager
- Import
- Backup
- Restore
- Utilities

Note: Only users with Administrator access (Administrator check box selected in Security Setup) have access to the Administration menu. Non-Administrator users do not have this menu on the Main Menu Bar.

Setup Menu
This menu contains options for performing setup tasks. Menu options are listed below:

- Enterprise Setup
- Desktop Setup
- Company Setup
- Module Setup
- User Setup
- Security Setup
- Security Setup - Module
- Table Setup
- Audit Setup
**Note:** Only users with Administrator access (Administrator check box selected in Security Setup) have access to the Setup menu. Non-Administrator users do not have this menu on the Main Menu Bar.

**Help Menu**

This menu contains options for the Help features within People-Trak. Menu options are listed below:

- Help Topics
- Support Online
- Help About

**Shortcut Bar**

The first column on the left-hand side of the Organizer desktop, called the Shortcut Bar, provides shortcut icons, much like Microsoft Outlook. These icons are used to more easily access important features of People-Trak without having to open the File menu.

**Modules Pane**

The Modules pane includes the list of the People-Trak modules that have been activated in Desktop Setup and to which you have been given access in Security Setup. To select a module, simply click on the module name.

**Categories Pane**

The Categories pane includes a list of categories that have been defined for the current module. The tree view hierarchy allows you to drill down into Activities, Processing, Documents, Tables and Workflows that exist within each category. In their respective processes, you can assign Documents and Workflows to an existing Category, which will then cause them to show up in this Categories pane under that category.

To open up a category, click the + sign to the left of the category. The + sign will turn to a – sign for that category, signifying that the category is now open. The subcategories (Activities, Processing, etc.) that have items in them will now be shown. As with the main category, click the + sign to open that category. The + sign will turn into a – sign for that subcategory, signifying that the subcategory is now open. The items in that subcategory will now be shown. To select an item, click on it. To close a category or subcategory, click the – sign to the left of that category/subcategory.

**Tasks Pane**

The Tasks pane includes a listing of frequently-used tasks that have been specified for the user within the Desktop Tasks screen found on the Preferences tab in User Setup. To select a task, click on it. The module will automatically switch based on the task selected, and the task will be executed. When the task is completed, you will be returned to the module you were in when you selected the task. The Tasks pane is a convenient way of accessing tasks that you use often. You have the option of grouping these tasks so you can open and close groups like you do for categories in the Categories pane. If you would like to see the extended descriptions for the task, hover over the task and a tool tip with the description will be displayed. The Tasks pane also includes a bar at the bottom with links to three standard activities: Help, Inbox and Logoff.
People-Trak News Pane

The People-Trak News pane includes links to the latest information provided by People-Trak. The links in this area will be updated nightly when running the NightRun process. You can view video tips, customer notifications and other important information to keep you up-to-date. There will be up to ten links as well as an Archive link, which accesses an index of past news items.

Status Bar

The Status Bar is displayed at the very bottom of the Organizer desktop. It contains panels for messages, a progress monitor, the People-Trak version, the database type, the system date, the user type and the record counter. The messages and progress monitor panels are blank until there is a message or processing in progress. The following example shows just the last five panels.

| 9.0.0 | SQL | 02/02/2012 | HR | 30 of 50 |

Note: In order to alert you, the numbers for the Record Counter will change colors as the number of records used approaches the number of records licensed. You will need to contact your Support Representative to license more records as needed.
Workflow Area

The Workflow Area is the area of the desktop that is used to process workflows. All desktops utilize the area below the Header and above the Status Bar for workflow processing.

A sample desktop with the Standard - Employee workflow open for processing is shown below.

Title Bar

The Title Bar is at the top of the Workflow Area and includes the name of the workflow that is currently being processed. The X on the right-hand side of the bar can be used to close the workflow (as can the Close Record option).

Menu Bar

The Menu Bar is below the Title Bar and above the Tool Bar. It includes the menus described below.

File Menu

The File menu contains several options for dealing with records as well as for printing the screen, viewing documents, sending email and editing the lookup.

When you see the Record placeholder in the descriptions below, this refers to the primary item being tracked by the module. On the actual menus, the Record placeholder will be replaced with the appropriate name. For example, for employee records tracked in the
Personnel Management module, the menu phrases will be “New Employee”, “Open Employee”, “Delete Employee”, etc. A similar, appropriate phrase applies to each module.

New Record
Open Record
Save Record
Close Record
Delete Record
Copy Record
Transfer Record
Print Screen
Record Status
Send Email
Edit Lookup
Exit

**Edit Menu**

The Edit menu contains several options used for editing fields.

The options on the Edit menu, as well as the corresponding buttons on the Tool Bar, turn on and off as the appropriate features are enabled.

Undo
Undo All
Cut
Copy
Paste
Delete Text
Date Stamp
Set Date Stamp
Select All
Insert Row
Delete Row
Row Up
Row Down

**Audit Menu**

The Audit menu contains several options used for viewing edit history, field audit history, as well as audit and transaction history.

Edit History
Field Audit History
Audit History
Transaction History

**Help Menu**

This menu contains options for the Help features within People-Trak. Menu options are listed below:

Help Topics
Support Online
Help About
Tool Bar

The Tool Bar is displayed between the Menu Bar and the Navigation and Category Bars. It contains buttons to do file, edit and help functions.

Buttons will be disabled when they are not applicable. For example, the four grid buttons above are disabled because the current field is not in a grid. The Tool Bar above is from a primary screen. A sub screen would not have the New, Open or Close buttons on its Tool Bar since those are only applicable on a primary screen. Toolbar buttons are listed below:

**Note:** Each People-Trak process also has a Tool Bar. The buttons are similar to those described below. Some buttons may not be available depending on the process. For example, the User Setup process has a Tool Bar identical to the one above, except the Open button is not applicable because a list box is used to select users to update.

When you see the *Record* placeholder in the descriptions below, this refers to the primary item being tracked by the module. On the tooltips, the *Record* placeholder will be replaced with the appropriate name. For example, for employee records tracked in a personnel module the tooltip phrases will be “New Employee”, “Open Employee”, “Delete Employee”, etc. A similar, appropriate phrase applies to each module.

- New *Record*
- Open *Record*
- Save *Record*
- Close *Record*
- Print Screen
- Cut
- Copy
- Paste
- Date Stamp
- Undo Current Field
- Insert Row
- Delete Row
- Row Up
- Row Down
- Show Field Help
- Show Screen Help

Navigation Bar

The Navigation Bar is displayed after the Tool Bar and before the main body of the screen. The Navigation Bar contains features used to navigate among the records that have been selected for editing.

**Record Dropdown**

Performs three functions. It displays the group of records established at lookup. It also displays the currently selected record. Lastly, it allows you to select from any of the records in the group. The group is initially filled using the Lookup option and can be modified using the Edit Lookup feature on the File menu.
**First Record**
Selects the first record in the group of records listed in the Record dropdown.

**Previous Record**
Selects the previous record in the group of records listed in the Record dropdown. If the first record is the current record, the last record becomes the current record.

**Record Counter**
Indicates the position of the current record relative to the group of records listed in the Record dropdown. For example, the phrase “4 of 30” indicates that the fourth record in a group of 30 is currently displayed. This message is updated whenever the current record is changed using the Record dropdown itself or when any of the First, Previous, Next, or Last buttons are used.

**Next Record**
Selects the next record in the group of records listed in the Record dropdown. If the last record is the current record, the first record becomes the current record.

**Last Record**
Selects the last record in the group of records listed in the Record dropdown.

**Category Bar**
The Category Bar is displayed after the Tool Bar and before the main body of the screen. The Category Bar is used to navigate among screens and category buttons available in the current module. The Screens dropdown performs three functions. It contains a list of the screens that you can access. It also displays the current screen name. Additionally, it allows you to select from any of the screens you can access. The list of screens in the dropdown is determined by the screens and categories to which you have been given access in Security Setup - Module. If you do not have access to a screen, it will not be listed in your Screen dropdown.

**Previous**
Selects the previous screen in the dropdown. If the first screen is the current screen, the last screen becomes the current screen and is displayed. The keyboard equivalent for the previous screen function is the PAGE UP key.

**Next**
Selects the next screen in the dropdown. If the last screen is the current screen, the first screen becomes the current screen and is displayed. The keyboard equivalent for the next screen function is the PAGE DOWN key.

**Category Documents**
Allows you to select the document and record type (Current Record, Current Group or Use Query) for which you want the document to run. Only documents assigned to the current category will be available.
Category Tables
Allows you to view and edit tables that have been assigned to the current category. Tables that are non editable are viewable as display only.

Category Notes
Allows you to view all notes that have been assigned to the current category. This button is only available if the Notes check box is selected for the user in Security Setup.

Category Help
Allows you to view help for all screens, tables, documents, templates, derived fields, processing and workflows that have been assigned to the current category.

Primary Screen Area
The actual body of the Workflow Area is the Primary Screen Area. Each workflow can have one or more primary screens, which can be selected using the Screen dropdown. The following is a sample of the Personal screen in the Standard-Employee workflow of the Personnel Management module.

Each primary screen can have sub screens, which are accessible via buttons. In the screen above, the Emergency through ID buttons on the right give you access to those sub screens when you click them. You can expect to see a very standard interface no matter what module you are currently in.
Data Validation

People-Trak uses two types of data validation: entry and post-entry.

**Entry Validation**
Entry validation occurs during the actual keying or “entry” of the field and is designed to prevent invalid characters from being entered into a field. Entry validation is limited to date fields, numeric fields, and time fields. If you are positioned to a date field and press an invalid character, the character will be ignored because the field knows what characters are valid. If you are positioned to a numeric field or a time field, the same is true. The field will limit characters to those that are valid.

**Post-Entry Validation**
People-Trak also uses “post-entry” validation. This occurs when you press the ENTER key or the TAB key to move the cursor to another field or when you use another key to change the cursor location. It also occurs when you use the mouse to move the cursor. During post-entry validation, the contents of the field are compared against pre-defined attributes of the field. If the data entered does not match the attributes of the field, the entry is rejected and the cursor remains at the field you had just requested to leave.

Post-entry validation is required because not all attributes of a field can be checked during entry and because of the cut, copy, and paste features. With the cut, copy, and paste features, you can take the contents of one field and move them to another. The data that has been moved is not validated until you attempt to leave the field. If you have pasted character data into a numeric field, you will not be able to leave the field until you have corrected or erased the entry.

Required Fields

**Default Required Fields**
By default, there is a single required field in each module. That field is the unique ID (employee ID, applicant ID, etc.) that identifies the record within the company. You cannot save a record without having specified a unique ID. If you attempt to save a new record without an ID, you will receive a message and you will not be able to save the record. If you attempt to change an existing ID to one that is in use elsewhere within the company, you will receive a message and the ID you have specified will be rejected.

If you have chosen to use the Auto-Numbering feature, the IDs that are generated will always be unique because they are checked before they are assigned.

**User Defined Required Fields**
People-Trak also allows you to make any field a required field. This is a very powerful feature that works as follows. If you position to a required field, you cannot leave that field unless you have specified a non-blank value. If you position to the field inadvertently and really do not wish to specify a value, you will not be able to leave the field until you provide some type of entry. In some instances, the only way you will be able to continue processing is to enter a temporary value.
If you have a required field on a screen and do not enter a value in that field, you will not be able to leave the screen (by any means) until a value is entered. Even if you do not position directly to that field, you will not be able to continue processing until that field is given a non-blank value. If you have a dozen required fields on a screen, you will not be able to leave the screen until a non-blank value has been specified for each and every field.

Note: This feature is a very attractive feature, but it is very powerful. If you really do not intend for a feature to be entirely required, do not use this feature or it will be very, very frustrating.

Formatting

People-Trak uses three types of data formatting: pre-entry, entry and post-entry. Some fields have their format based on the PC’s regional settings or the company settings.

Pre-Entry Formatting
People-Trak stores all data in the database in a non-formatted way. Pre-entry formatting refers to the formatting that occurs when the data is moved from the database into the field. Dates, times, numeric values, telephone numbers and social security numbers are all translated from their raw storage format into the formats you have specified in the PC’s regional settings or in your company settings.

Entry Formatting
Entry formatting refers to the formatting that occurs when a field is entered. This type of formatting is limited to date fields, which are difficult to key because of the date separator. If you have selected Auto-Delimit in User Setup, the separator (determined by the PC’s regional date format setting) is automatically inserted for you when dates are keyed. So, you can simply key the numbers and assume that the field will be formatted correctly.

Post-Entry Formatting
Post-entry formatting refers to the formatting that occurs when a field has been completed. Numeric fields, telephone numbers, and social security numbers are all formatted after they have been entered, even if they have been keyed with separators, commas, or decimals. The same is true for dates if you have not selected Auto-Delimit in User Setup; in that case, the date is formatted to the PC’s regional 10-character date format after entry. Other types of formatting are also performed post-entry.

People-Trak supports three types of case formatting on alpha-numeric fields: none, proper case, and upper case. If you have specified the proper case format for the City field, the field will be proper cased when you leave the field. For example, if you enter any of the following: san diego, SAN DIEGO, sAN DIEgo, the field will be switched to San Diego. Likewise, if you specified the upper case format for the City field and you enter any of the following: san diego, San Diego, SAN Diego, the field will be switched to SAN DIEGO when you leave the field.

Cut, Copy, and Paste

People-Trak uses standard Windows cut, copy, and paste conventions at all data entry fields.

Cut
The cut feature is used to cut the highlighted contents of a field. Cut removes the highlighted contents and stores the contents in the paste buffer. Cut text can be pasted into any other applicable field using the Paste option on the Edit menu, the Paste button on the Tool Bar, or
the CTRL + INS or CTRL + V key sequence. The Cut feature is available on the Edit menu, as a button on the Tool Bar, and as the CTRL + X key sequence.

**Copy**

The copy feature is used to copy the highlighted contents of a field into the paste buffer. Text in the paste buffer can be pasted into any other applicable field using the Paste option on the Edit menu, the Paste button on the Tool Bar, or the CTRL + INS or CTRL + V key sequence. The Copy option is available on the Edit menu, as a button on the Tool Bar, and as the CTRL + INS or CTRL + C key sequence.

**Paste**

The paste feature is used to paste the contents of the paste buffer into any applicable field. The paste buffer is a Windows feature and can contain text that has been pasted from another product. For example, if you copy the text of an email message in some unrelated task, that text is placed into the same paste buffer that is available within People-Trak. The paste buffer is not emptied after a paste action, but can be used over and over again. In fact, the paste buffer remains until another item has been cut or copied into the paste buffer or until Windows is shut down. The Paste option is available on the Edit menu, as a button on the Tool Bar, and as the SHIFT + INS or CTRL + V key sequence.

**Note:** The paste feature allows you to paste invalid data into fields that have special formatting attributes. For example, if you cut or copy an employee last name into the paste buffer, you will be able to paste it into both date fields and numeric fields. These types of fields do not allow character style data and would normally disallow data entry of such characters. When you attempt to leave a field that contains invalid data, the post-entry validation feature will prevent you from leaving the field until you have corrected it.

**Date Stamp**

People-Trak provides a special capability at date fields that allows the rapid insertion of the current setting of the date stamp. The date stamp capability simulates the mechanical date stamp that has been used for many years to stamp documents and mail. The date stamp is a special paste buffer. It is filled with the current date when an editing session begins, but can be modified at any time using the Set Date Stamp option on the Edit menu. When the cursor is positioned to a date field, use the Date Stamp to instantly insert a date into the field.

On certain screens that have a wide variety of date fields, the Date Stamp feature may not be useful. However, with Batch Processing processes where you will need to enter the same date many times, this feature can save a great deal of time. The Date Stamp feature is available on the Edit menu, as a button on the Tool Bar, and as the F4 key.

**Exiting a Record or Screen**

In a record or in any screen with the Save capability, the record/screen can be exited in one of two ways: using the Exit option on the File menu or clicking the “X” in the upper right-hand corner of the Workflow Area or screen. The Exit option automatically saves any changes and exits the screen. Clicking the “X” asks you if you want to save when changes are made, saves or doesn’t save according to your answer and then exits the screen. On a screen without the Save capability, the Exit and “X” both just exit the screen because no save is involved.

**Note:** When editing a record and exiting a sub screen, you are saving changes to the sub screen only. Changes to the record are only saved when saving the record itself. In addition, if you have accessed the same sub screen multiple times before saving the record, clicking “X”
and saying “No” to the save question only discards the current editing session’s changes to that sub screen not all changes to the sub screen.

Enable Preselect

People-Trak adheres to an operating convention that differs from the standard Windows convention. When the cursor is first positioned to a field, Windows normally pre-selects the entire entry. If you press any key, the current entry is wiped out and is replaced with whatever you type. In the People-Trak standard, the field is not pre-selected.

If you prefer to use the Windows standard for entry selection, you can change the setting of the Enable Preselect check box on the Preferences tab of User Setup. When the check box is selected, the Windows standard applies, and an entry will be pre-selected. When the check box is not selected, the People-Trak standard applies, and an entry will not be pre-selected. This check box is not selected by default.

Change the Enable Preselect Setting
The Enable Preselect setting can be switched at any time. The System Administrator can switch modes for any user using the User Setup option on the Setup menu.

Color Conventions

People-Trak provides user definable colors for four data edit characteristics: normal data, modified data, field mask and pending data.

Normal Color
The normal color is the color in which data is displayed when no change has been made to the field. The default color for normal data is blue.

Modified Color
The modified data color is the color in which data is displayed after a change has been made to that field, but before it has been saved. The default color for modified data is red.

Mask Color
The field mask is that area that surrounds a field when the cursor is positioned to that field. The field mask is visible on both text boxes and grids. The default color for the field mask is yellow.

Note: The mask color is also used as the highlight color on most drop-downs and list boxes.

Pending Color
The pending color is the color in which data is displayed after a change has been made to the field and saved, but before the change has been approved and posted. The default color for pending data is magenta.

Note: If Self Service options are implemented, a pending color is used.

Changing Color Preferences
The four data colors can be modified for any color scheme at any time. An Administrator can modify the color preferences for any scheme using the Define Colors button within User Setup, the Set Colors button in Desktop Setup, or the Maintain Color Schemes utility.

The changes take effect immediately. You can confirm this by using the updated color scheme (assign that scheme to your user in User Setup) and then using any editing screen.
Caution: It is possible to select a combination of colors that will cause data to disappear. For example, if you select a dark blue mask with dark blue unmodified data, the data will not be visible when the field is highlighted.

Note: The frame, background and font colors in a color scheme can also be changed using this procedure. New color schemes can also be created and then assigned using User Setup.

Using the Undo Feature

When Changes are Saved
People-Trak saves data when you close the record, exit the record, change records, click the save icon, or use the Close button in the upper right hand of the screen and choose to save. If you decide to abandon changes in process on a given screen, you may do so by using the Close button and choosing not to save.

The Edit History Log
People-Trak maintains an ongoing edit history while you are editing and before changes are saved. Every change is recorded as it is actually made. You can view the log at any time using the Edit History option from the Audit menu.

Undo
The Undo feature can be used to undo data entry that has been performed on any field. The feature is very powerful in that you can selectively undo any change that has not yet been saved to the database. Fields that have been changed are displayed in the modified color rather than the normal color. When you position the cursor to any modified field, the Undo button on the Tool Bar will be activated as will the Undo option on the Edit menu. If you click the button or select the option, the prior value of the field will be restored.

The Undo feature uses the Edit History Log. Thus, it is possible to have multiple changes to the same field that can be undone. After using the Undo feature to undo the latest change, the Edit History Log is checked to determine if there any other changes to the same field for the current record. If there are, the field remains in the modified color and the Undo button and option remain active. When the last change has been undone, the color is returned to the normal color and the button and option are deactivated.

Note: The Undo feature undoes changes made to individual fields during an editing session. It does not undo changes made in bulk using batch processing, import, table mass update, or database manager. It is highly recommended that you perform a quick backup prior to performing any type of bulk change.

Undo All
If multiple changes have been made during the current edit session on one or more screens, including row deletes, you can undo all of those changes at one time using this option. The Undo All feature uses the Edit History Log to sequentially back out all of the changes that have been recorded in the log. However, any actions taken by triggers cannot be undone. In addition, a change to the record ID field cannot be undone because that information is written to the database upon leaving the field.

Note: When using any undo features, only changes made since the last save can be undone.
Working with Grids

As described in the vocabulary sections, grids are a special class of data entry component. A sample grid is shown below.

Grids are used to display rows and columns of information. The rows often represent multiple occurrences of historical data. For example, a grid can be used to store salary history. There are columns for the salary date, hours per week, salary rate, annualized pay, etc., that are repeated as rows for each salary history. With a few exceptions, a grid can contain as many rows as you can enter.

Capacity
As mentioned above, most of the grids in People-Trak can contain as many rows as you choose to enter. However, to manage the scroll bar properly and to maximize speed, only 50 rows can be entered at one time. When you first display a screen that utilizes a grid, the grid is populated with 50 blank rows. If you enter 20 rows and leave the screen, but then return, you will have room for the original 20 rows plus 50 additional rows. Each time you return to the grid, you will have the number of existing rows plus 50. If you need to enter more than 50 rows into a grid at one time, you can click Save and 50 more blank rows will be added to the grid.

Navigation
Once the cursor has been positioned within a grid, the following navigation keys apply.

- TAB or ENTER
- SHIFT + TAB
- DOWN ARROW
- UP ARROW
- Scroll Bar
- Mouse Clicks

TAB or ENTER moves to the next field in the current row. If the cursor is at the last field in the current row, the cursor moves to the first field on the next row.

SHIFT + TAB moves to the prior field in the current row. If the cursor is at the first field in the current row, the cursor moves to the last field on the prior row.

DOWN ARROW moves the cursor to the next row within the same column.

UP ARROW moves the cursor to the prior row within the same column.

Scroll Bar scrolls the visible portion of the grid, but does not move the actual cursor. For example, if the cursor is on the first row and you scroll the first row out of view, the cursor remains on the first row. If you scroll the first back into view, the cursor will be present where you left it.

Mouse Clicks can be used to position the cursor to any editable cell. If you are positioning to a cell that contains data, the first click will position to the cell and the second click (within the same cell) will position the cursor within the data itself.

Editing
A grid actually acts like a report upon which a movable text box is positioned. When the text box is positioned over a cell (row and column location), the contents of the cell are put into the text box. If you modify the text box, the change is moved back into the cell when you
Operating Conventions

Essential User Interface

leave the cell. Because the movable text box works precisely like the stand-alone text boxes used elsewhere, the operating conventions are identical. All keystrokes, undo features, tables, and other popup features work the same.

Similarly, a check box is positioned over cells that utilize the check box attribute. Once the cursor is positioned to the cell, the check box component takes on the current attribute of the cell (checked or unchecked). If you toggle the check box and then move on, the cell takes on the new status of the check box.

When working with grids, the mask color feature is tremendously helpful. Both the text box cells and the check box cells are more easily identified as having the focus when they are highlighted with a light color such as yellow.

Inserting and Deleting Rows

Because grids contain rows of information, you can insert and delete rows whenever you choose. A blank row can be inserted at any location using the Insert Row feature. This feature is activated with the Insert Row button on the Tool Bar, the Insert Row option on the Edit menu or Function Key 9. Once the blank row has been inserted, you can complete the columns in the row by adding the appropriate information.

A blank row or previously completed row can be deleted at any time using the Delete Row feature. This feature is activated with the Delete Row button on the Tool Bar, the Delete Row option on the Edit menu or Function Key 8. Deleting a row discards a number of fields at once and should be used with some caution. It is not possible to use the standard Undo feature to undo the fields that have been deleted. However, if multiple changes have been made during the current edit session, including row deletes, you can undo all of those changes at one time using the Undo All option. The Undo All feature uses the Edit History Log to sequentially back out all of the changes that have been recorded in the log.

Note: When using any undo features, only changes made since the last save can be undone.

Field Types

People-Trak uses the set of standard field types listed below. The operating conventions and formatting attributes for these fields are consistent throughout People-Trak.

- Color
- Currency
- Date
- File
- Font
- Memo
- Numeric
- Object
- Path
- Text
- Time
- Yes/No

Color

Color fields are used to capture the color attribute for some particular feature. Color fields do not store actual color names, but reflect the color actually selected. To change the color, use the color popup to select the new color with the mouse.

Currency

Currency fields are used to store positive or negative numbers with or without decimal places. Two values determine the actual format of a currency field: the length of the field and the number of decimal places.
### Field Length and Decimal Places

The field length and decimal places for currency fields are user defined and can be modified with the Field Customization feature. Thus, if the default `##########.##` format of the Pay Rate field is not acceptable to you, you can change it to any reasonable length with up to four decimal places.

Currency fields differ from numeric fields in that when a document is run, a currency symbol appears next to the currency field, but not next to the numeric field. The currency symbol is defined in Company Setup.

#### Date

Date fields are also widely used in People-Trak. Date fields are the only fields that have the option of using “real-time” formatting. This means that the field is formatted as you enter it. People-Trak is shipped with the Auto-Delimit feature turned on in User Setup. Auto Delimit is a check box that allows you to specify whether or not you want date delimiters automatically entered for you when entering a date. If this check box is selected, only numbers can be entered in a date field and the delimiter specified in the PC’s regional date format setting is automatically entered in the correct positions. If this check box is not selected, numbers and a delimiter of “.”, “/” or “-” can be entered in a date field, and the field is formatted to the PC’s regional 10-character date format after it is entered. For example, if you type in “3.4.9” and press ENTER, the date will be formatted to 03-04-2009 if the PC’s date format is m-d-yyyy, mm-dd-yyyy or some variation of that.

Date fields are also supported by the date popup. It uses a calendar to allow you to pick a date using a series of mouse clicks for the month, day, and year. Some date fields are also supported by the date variables popup, which allows you to select from a list of date variables.

#### File

File fields store the full file name of a file. File fields work just like a text field in that any value can be keyed. However, when a file is entered, it is validated to determine if it actually exists. You cannot record a file that does exist or cannot be validated. File fields are supported by the file popup.

#### Font

A font field is actually composed of three different fields: font name, font style, and font size. When a font is specified for a particular feature it requires all three entries to define the font. To change or set a font, use the font popup to select the three desired attributes.

#### Memo

Memo fields are text fields that can be over 255 characters. Regular text fields have a maximum of 255 characters. In a memo field, you can enter the text in the field itself or use the multi-line editor popup to enter more than a single line of text. The maximum size of a memo field is 2 GB of data.
Numeric

Numeric fields are used to store positive or negative numbers with or without decimal places. Two values determine the actual format of a numeric field: the length of the field and the number of decimals.

###.##  Length = 6, decimal places = 2
#####  Length = 6, decimal places = 0
######.##  Length = 9, decimal places = 2
#####.###  Length = 10, decimal places = 4

The field length and decimal places for most numeric fields are user defined and can be modified with the Field Customization feature. Thus, if the default ####.## format of the Standard Hours field is not acceptable to you, you can change it to any reasonable length with up to four decimal places.

The numeric separator and decimal symbol can be based on the PC’s regional settings or the company’s settings. For documents, the company’s settings are always used for numeric fields. In Company Setup these fields are currently inactive and set to display only.

Object

Object fields are used to store images. An example is the Employee Photo ID field.

Path

Path fields store a directory path. Path fields work just like a text field in that any value can be keyed. However, when a path is entered, it is validated to determine if it actually exists. You cannot record a path that does exist or cannot be validated. Path fields are supported by the path popup.

Text

Text fields are the most common type of field. They vary in length from one character to 255 characters and can contain almost any printable character on the keyboard. In a text field, you can enter the text in the field itself or use the multi-line editor popup (if available) to enter more than a single line of text.

Many text fields are supported by tables. Tables are user-defined lists from which values can be selected. When a field is supported by a table, the table popup button will be displayed adjacent to the field itself.

There are a number of attributes that can be assigned to text fields. These attributes determine how the contents of the field are displayed when the field is first retrieved from the database and immediately after a change has been made.

- Email
- Hyperlink
- None
- Proper Case
- Social Security
- Telephone
- Upper Case

Email causes the contents of the field to be validated for relevance as an email address. This also enables the Email popup to be displayed.
For a Hyperlink, no formatting is done on the field, but this setting sets the Popup Type to Hyperlink, which makes this field a hyperlink to whatever website, ftp site or file is in the field.

None causes the field to remain as keyed. No action is taken on the field.

Proper Case causes the contents of the field to be formatted according to standard proper case rules. Except for certain ethnic conventions (such as those used for Irish and Scottish names), this normally means that the first character of each word is set in upper case with the remainder of the name in lower case. Other phrases, particularly those used in an address such as RR, PO, etc., follow normal case conventions.

Social Security causes the contents of the field to be formatted in one of the following ways. The actual format that you use is defined for the company using the Company Setup process.

United States

Canadian

Telephone causes the contents of the field to be formatted in one of the following ways. The actual format that you use is defined for the company using the Company Setup process.

(###) ###-####

###.###-####

### ###-####

###-###-####

Upper Case causes the contents of the field to be forced to upper case.

Note: Attributes for text fields can be changed using the Field Customization feature. The single quotation mark, double quotation mark, and bracket characters are not allowed in a text field. If these character keys are pressed, the keystrokes will be discarded.

Time

Time fields are used to store a time. The actual format used is based on the company’s settings. For documents, the company’s settings are always used for time fields.

Time fields are supported by the time popup. It uses an hour list, minute list, and AM/PM indicates to allow you to pick a time using mouse clicks rather than keying the time directly.

Yes/No

Yes/No fields use check boxes to capture the Yes or No value.

Popups

People-Trak provides a number of popup features to enable you to complete the entries in fields. The following is a list of the standard popups:

- Color
- Date
- Document
- Email
- Field
- File
- Font
- Hyperlink
- Path
- Multi-Line Editor
- Table
- Time
As the cursor is moved around on a screen, different popup buttons are displayed adjacent to the text boxes to indicate the availability of a popup. Each popup listed above has its own popup button.

**Color Popup**

When the cursor is positioned to a color field, the only way you can select a color is to use the Color popup. When you click the popup button in a color field, a screen similar to the one shown below is displayed with the current color in the large square.

![Select Color](image)

This popup allows you to select one of eleven basic colors or create a custom color. If you want to create a custom color, you can select Custom and then you will be taken to the more complex Color screen as shown below.

![Color](image)

This color popup provides a list of basic colors and custom colors, a color spectrum area and a color preview (Color|Solid) area. When the popup is first displayed, the color preview area shows the color attribute of the current field. You can select any other color by clicking on the appropriate color field. The field will be reflected in the color preview area. You can also select any color field and then change its spectrum settings on the right to create a custom color. If you want to save that custom color for future use, click on one of the available custom color fields and then click the Add to Custom Colors button to add that custom color to that location. When the appropriate color has been selected or created, click the OK button to return the color to the field, or you can click the Cancel button to return to the color field without taking any action.
Date Popup
When a cursor is positioned to a date field, you can enter a date in one of three ways. You can key the date directly, you can enter the date using the Date Stamp feature, or you can use the Date popup. If you click the popup button, the screen shown below is displayed.

When the date popup is first displayed, the calendar is adjusted to display either the date currently in the field or the current date if the field is blank. You can move around the calendars using the various buttons until the date desired is displayed. You can then click the OK button to return the date to the field, or you can click the Cancel button to return to the date field without taking any action.

Document Popup
When the cursor is positioned to a document field, you can enter the document name directly or you can select a document using the Document popup. When you click the popup button, the screen shown below is displayed.

The document popup provides a list of document categories on the left and the documents in the highlighted category on the right. When you have located and highlighted the desired document, you can press ENTER, click the OK button or double-click the entry to return the document to the field, or you can click the Cancel button to return to the document field without taking any action.
Email Popup

When the cursor is positioned to a field supported by the email feature, you can click the popup button and send an email using the Send Email screen shown below.

![Send Email Screen]

Field Popup

When the cursor is positioned to a field supported by the list of fields in the module, you can enter the field name in one of two ways. You can enter the field name directly or you can use the field popup. If you click the popup button, the screen shown below is displayed.

![Select Field Screen]

The field popup has a list of field categories on the left and a list of the fields in the current category on the right. There are five different types of field categories, which are listed below in the order they are found in the listing on the left side of the Select Field screen:
All Fields  This category includes all of the fields (including derived fields) in the current module in alphabetic order.

Category  Each of the regular data entry and compound (created for you by putting regular fields together, i.e. Full Name) fields in People-Trak is assigned to a category. All of the different categories are listed.

Notes  This category includes all of the note fields.

System  This category includes system fields and is only available within templates.

To select a field, click on the appropriate category in the list on the left. The fields in that category will then be displayed on the right. When you have located and highlighted the desired field, you can press ENTER, click the OK button or double-click the entry to return the field name to the field, or you can click the Cancel button to return to the field without taking any action.

**File Popup**

When the cursor is positioned to a File field, you can enter a file in one of two ways. You can key the entire path and filename or you can use the file popup. If you click the popup button, the screen shown below is displayed.

![Select File](image)

The file popup allows you to move through drives, folders, and files until you find the desired file, just like Windows Explorer. The current path and file is displayed in the text box at the bottom of the form. When the desired file has been selected, you can click the OK button to return the complete path and filename to the field or you can click the Cancel button to return to the field without taking any action.

**Font Popup**

When the cursor is positioned to a Font field, the only way you can select a font is to use the Font popup. If you click the popup button, the screen shown below is displayed.
The font popup allows you to select the font name, the font style, and the font size. A preview section also allows you to see just what the font looks like with those attributes. When the popup is first displayed, the current settings for the name, style, and size are selected and the preview also reflects these settings. You can select any combination of these settings and monitor the visual effect in the preview section. When you are satisfied with your selections, you can click the OK button to return the three values to their respective fields on the screen, or you can click the Cancel button to return to the font field without taking any action.

**Hyperlink Popup**

When the cursor is positioned to a hyperlinked field, you can execute the hyperlink by clicking on the popup button 1. A hyperlinked field can contain a website address, ftp site address or a filename. EXE and BAT files are not allowed.

**Path Popup**

When the cursor is positioned to a Path field, you can enter a path in one of two ways. You can enter the entire directory path or you can use the path popup. If you click the path popup button 2, a Select Path screen similar to the Select File screen is shown, except that no files are displayed or can be selected.

**Multi-Line Editor Popup**

When the cursor is positioned to a multi-line field, you can key short phrases directly into the field. However, if you wish to key more text, or if you wish to view text that is not visible on the multi-line field, you should use the Multi-Line Editor popup. If you click the popup button 3, the screen shown below is displayed.
The multi-line editor popup allows you to key text using the ENTER key and with full scrolling features without the cursor moving to other fields. While the multi-line field on the original screen has a fixed size, the multi-line editor adjusts to fit the amount of text that has been entered. Thus, the editor not only acts as a place to key information, it allows you to view information that would not otherwise be visible.

When the desired text has been keyed or modified, you can click the OK button to return the text to the field, or you can click the Cancel button to return to the field without taking any action.

**Tables and the Table Popup**

People-Trak makes extensive use of tables. Tables are lists that contain user-defined or system-defined entries. These lists are available to assist in filling the corresponding fields in a given record. For example, the State field is a table field. Behind the State field is a table containing a list of states. When the cursor is positioned to the State field, the table can be used to validate the state code entered, or to directly select the state from the table.

People-Trak utilizes both “system” tables and “user” tables. System tables are those that have been pre-defined within the product. These include custom report operators, links, date substitution variables and others, and cannot be changed. User tables are defined for use within the system, but are filled by the user as needed. User tables include cities, states, codes, and many others.

**Table Validation**

The validation of entries against each individual table can be set to three different levels: None, Optional, and Mandatory. When there is no validation (None), the table is simply ignored. When validation is Optional and a non-matching entry is made, the following message is displayed:

Entry is not in the table, Override Table?

Because the table is optional, the value can be accepted even though it is not in the table. To override the table and leave the entry, enter Yes. To discard the entry, enter No.

When validation is Mandatory and a non-matching entry is made, the following message is displayed:

Entry is not in the table

When any key is pressed, the entry is discarded and the cursor is returned to the field.

**Note:** When an optional table entry overrides the table, that entry is NOT moved into the table automatically. If you wish to move the entry into the table, it must be done using the table entry feature for that table.

**Data Entry Using Tables**

Table entries can be inserted into the record being edited in two ways. The first way is using the popup. The popup can be activated in two ways: the F3 key or the Table popup button \[\] adjacent to the field itself. When the popup is activated, the Select Tablename window is displayed. A sample is shown below.
An entry can be selected using standard techniques or manually entered. If that table has mapped fields, they are automatically inserted into the record being edited, changed to the modified color and set to display only.

Tables are not available at every field. Whenever a table is available, the Table popup button is displayed to the immediate right of the field.

**Note:** The fields that are supported by tables and the tables used to support fields can be modified at any time using the Field Customization feature. It is possible to add table support to any text box based field. Table maps are maintained in the Map Table Fields utility.

**Table Auto-Positioning**
When you pop up a table and the field already contains an existing entry in the table, the current value is selected and highlighted.

**Time Popup**
When the cursor is positioned to a time field, you can enter a time in one of two ways. You can key the time directly or you can use the Time popup. If you click the popup button, the screen shown below is displayed.
The time popup provides a list box for the hour, a list box for the minutes, and two radio buttons to select AM or PM. When the time popup is first displayed, the list boxes and the radio buttons are adjusted to reflect the current value of the field if the field is not blank or the current time if the field is blank. You can use the features of the screen until the desired time is displayed. You can then click the OK button to return the time to the field, or you can click the Cancel button to return to the time field without taking any action.

**Search Feature within Field, Document and Table Popups**
In field, document and table popups, you can enter a single character or multiple characters to jump to the first entry that starts with that character or characters. For example, when in one of these popups, if you enter the letter “S”, you will be taken to the first entry in the popup that starts with the letter “S”. If you wait two seconds or more and then type in the letter “A”, you will be taken to the first entry in the popup that starts with the letter “A”. If you type in the letters “SAN” quickly, you will be taken to the first entry that starts with the letters “SAN”.

**Key Functions**
The following is a list and description of the standard key functions, in alphabetic order.

**BACKSPACE**
Moves the cursor to the left one character while deleting the character on which the cursor is sitting.

**CTRL + PAGE DOWN**
Selects the next available record in the record dropdown. If the last record is the current record, the first record becomes the current record and is displayed. This feature is only applicable when editing records. The next record function is also available using the Next Record button on the Tool Bar.

**CTRL + PAGE UP**
Selects the previous record in the record dropdown. If the first record is the current record, the last record becomes the current record and is displayed. This feature is only applicable when editing records. The previous record function is also available using the Previous Record button on the Tool Bar.

**DELETE**
Deletes the currently highlighted text within a field. If no text is highlighted, it will delete one character of text at a time.

**DOWN ARROW**
Moves the cursor from the current field to the next field. If the cursor is positioned to the last field on the screen, it is moved to the first field on the screen. On a grid, the DOWN ARROW key moves the cursor down one row while remaining in the current column.

**END**
Moves the cursor to the end of the current field.

**ENTER**
Moves the cursor to the next field. On a screen, the ENTER key will cause the cursor to cycle through all of the fields. When the cursor is positioned to the last field on the screen,
the cursor will move to the first field on the screen. On a grid, if the cursor is positioned to the last field in a row, the cursor moves to the first field on the next row.

**F1**
Displays field properties and field help. SHIFT + F1 displays screen help.

**F2**
Invokes the Open Record feature.

**F3**
Invokes any applicable popup feature for the current field.

**F4**
On a Date field: Activates the date stamp feature and places the current value of the date stamp into the current field. On a Time field: Places the current time into the current field.

**F5**
Invokes the Run/Edit feature.

**F6**
Invokes the Print Screen feature.

**F8**
Deletes the current row on a grid. All subsequent rows are pulled up to fill the deleted space. The Delete Row option is also available as an option on the Edit menu and as a button on the Tool Bar.

**F9**
Inserts a new blank row into a grid at the current row. All subsequent rows are pushed down to accommodate the new row. The Insert Row option is also available as an option on the Edit menu and as a button on the Tool Bar.

**F10**
Moves cursor to the first menu on the Menu Bar. (Microsoft Standard)

**HOME**
Moves the cursor to the beginning of the current field.

**LEFT ARROW**
Moves the cursor from the current character in the field to the previous character in the field. If the cursor is positioned to the first character in the field, the cursor does not move.

**PAGE DOWN**
Selects the next available screen in the screen dropdown. If the last screen is the current screen, the first screen becomes the current screen and is displayed. This feature is only applicable when editing records. The next screen function is also available using the Next Screen button on the Tool Bar.

**PAGE UP**
Selects the previous screen in the screen dropdown. If the first screen is the current record, the last screen becomes the current screen and is displayed. This feature is only applicable
when editing records. The previous screen function is also available using the Previous Screen button on the Tool Bar.

**RIGHT ARROW**
Moves the cursor from the current character in a field to the next character in the field. If the cursor is positioned to the last character in the field, the cursor does not move.

**SHIFT + TAB**
Moves the cursor from the current field to the prior field. On a screen, SHIFT + TAB will cause the cursor to cycle through all of the fields. When the cursor is positioned to the first field on the screen, the cursor will move to the last field on the screen. On a grid, the cursor is moved backward one field on the current row. If the cursor is positioned to the first field on the row, the cursor is moved to the last field on the prior row.

**SPACEBAR**
Toggles a check box from selected to cleared or vice versa.

**TAB**
Within a field, the TAB key is used to save the additions or changes that have been made and to move the cursor to the next field. The TAB key is also used to move the focus from one command button to another.

**UP ARROW**
Moves the cursor from the current field to the previous field. If the cursor is positioned to the first field on the screen, it is moved to the last field on the screen. On a grid, the UP ARROW key moves the cursor up one row while remaining in the current column.

**File Menu Functions**

The File menu is used throughout People-Trak to perform various file functions. **Note:** In the procedures below, it is assumed you are already in the appropriate item screen, and when you see the Item placeholder, this refers to the item that is using the procedure. For example, when you are copying an Adhoc Report, you need to be in the Explorer - Adhoc Reports screen and the Copy Item phrase is actually Copy Adhoc Report on the File menu.

**New**
Creates a new item with an item name of “NEW-” followed by a sequential number. For example, if you create a new Adhoc Report, the report name will be NEW-1. If that report name already exists, the report name will be NEW-2, and so on.

**Save**
Saves the current item to the database and stays in that current item.

**Delete**
Deletes the current item from the database.

**Copy**
Creates a new item just like the New function, except with an item name of the copied item’s name with “-1” appended. If the “-1” item name exists, the name of the new item will have a “-2” appended, and so on. It then copies the original item over that new item. For example, if you copy the Alphabetic Employee List document, a new document with the name
Alphabetic Employee List-1 is created as an exact copy of the original document. If that report name already exists, the report name will be Alphabetic Employee List-2, and so on.
Desktop Setup

Overview

The Desktop Setup process on the Setup menu allows you to specify for each user type the settings necessary to create the screen used to log into People-Trak and to create the desktops. The desktop settings affect some of the “look” of the desktops, but most of the content of the desktops are defined in Company Setup and User Setup.

User types are used in People-Trak to determine what People-Trak desktop and functionality is available to a user. People-Trak supports the following user types:

- HR - HR User
- Employee - Employee Self-Service User (ESS)
- Manager - Manager Self-Service User (MSS)
- Ex-Employee - Ex Employee Self Service User (Ex-e)
- Applicant - Career Center User (CC)
- Visitor - Visitor User

The HR user type is the only one available in the base People-Trak Essential HR product. The Employee, Manager, and Ex-Employee user types are added when Self Service Employee/Manager has been implemented. The Applicant and Visitors are added with the implementation of Self Service Recruiting.

Desktop Setup Screen

The Desktop Setup screen uses several tabs to record and maintain setup information for the Login screen and desktops. The available user types are listed on the left.

Login Settings Tab

The Login Settings tab is used to specify key settings needed for the Login screen.

Each of the fields on this tab is used to specify what a certain part of the Login screen will look like or what text it will contain.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Caption</td>
<td>The caption to be displayed at the top of the Login screen.</td>
</tr>
<tr>
<td>Login Welcome Text</td>
<td>The text to be displayed in the welcome area of the Login screen. This field is supported by the multi-line editor popup.</td>
</tr>
<tr>
<td>Login Image</td>
<td>The image to be displayed on the Login screen. This field is supported by the Select File popup. The dimensions of this image are 260 pixels wide by 260 pixels high.</td>
</tr>
</tbody>
</table>
**Desktop Tab**

The Desktop tab is used to specify key settings needed for the desktops.

**Overall Settings**

**Color Scheme**

The color scheme to use for the Login screen for this user type. Once the user logs in, the color scheme is switched to the color scheme for that specific user. This field is supported by the Select Color Scheme popup.

**Desktop Alignment**

The desktop alignment to use when the resolution of the user monitor exceeds People-Trak’s standard minimum resolution of 1024 x 768. The alignment can be Left, Center or Right. This field is supported by the Select Position popup.

**Button Functions**

**Set Colors**

Allows you to maintain color schemes. When you click on this button the Maintain Color Schemes utility is run, and the color scheme assigned to the user type is automatically selected. The color schemes you maintain there are available for selection in the Scheme Name field.

**Web Settings**

The following settings are used when running People-Trak on the Web.

**Default Web Page Width**

The default web page width in pixels.

**Default Web Client Height**

The default web client height in pixels.

**Use Custom Header**

A check box that allows you to specify whether or not a custom header should be used for the desktop. Select the check box to use a custom header, which then ignores other heading settings. Clear the check box to not use a custom header.

**Web Header Height**

The default web header height in pixels. This field is only applicable if Use Custom Header is selected.

**Heading Logo**

The image to use for the heading logo. This field is supported by the Select Image popup so the appropriate image can be selected and the Clear Image popup so an existing image can be cleared. The dimensions of this image are 206 pixels wide by the height specified in the Web Header Height field. This field is only applicable if Use Custom Header is selected.
Logos and Header Tab
The Logos and Header tab is used to select the logos and specify the header settings for the enterprise.

Logos

Document Logo
The image to use for the document logo. This field is supported by the Select Image popup so the appropriate image can be selected and the Clear Image popup so an existing image can be cleared. The dimensions of this image are 206 pixels wide by 74 pixels high.

Heading Logo
The image to use for the heading logo. This field is supported by the Select Image popup so the appropriate image can be selected and the Clear Image popup so an existing image can be cleared. The dimensions of this image are 1040 pixels wide by 80 pixels high.

Note: If the image itself is not as big as the dimensions provided, it is important that it be sized big enough (using white space for example) to accommodate the placement of header text if that option is being used. Otherwise, the header text will not be visible.

Header

Enterprise Header Only
A check box that allows you to specify whether or not to use the enterprise header for the desktops in addition to the Login screen. Select the check box to only use the enterprise header; this means that the company logo and name will not be used in the desktop headers. Clear the check box to use the enterprise header on the Login screen and the company header on the desktops.

Include Header Text
A check box that allows you to specify whether or not you want the header text included in the header of the Login screen and desktops. Select the check box to include the header text in the header. Clear the check box to not include any header text in the header.

Header Text Alignment
The alignment to use for the header text. This field is supported by the Select Position popup. If they Include Header Text check box is not selected, which means the header text is not even shown, this alignment is irrelevant.

Name
The name of the font to be used for the header text. This field is supported by the Font popup.

Style
The style of the font to be used for the header text. This field is for display only because it is set using the Font popup on the Font Name field.

Size
The size of the font to be used for the header text. This field is for display only because it is set using the Font popup on the Font Name field.

Color
The color to be used for the header text. This field is supported by the Color popup.

Organizer Tab
The Organizer tab is used to specify what modules are active in the modules pane of the Organizer desktop.
**Tasks Tab**

The Desktop Tasks tab is used to define the default desktop tasks for the selected user type. These tasks can then be used to populate the tasks for individual users within User Setup.

Tasks from all modules are available for inclusion in this list of desktop tasks. This allows the user to easily access any tasks, without needing to switch modules or find the options on menus.

**Group**

The group name for this task, if any. This is a freeform text field, which allows you to group tasks however you want. If you do choose to use groups, it is important that all tasks for each group be kept together in the tasks grid. If groups are used, a task tree will be present in the Tasks pane with groups as the first level and tasks as the second level. If groups are not used, tasks will simply be listed in the Tasks pane.

**Module**

The list of modules available to the particular user. This field is supported by the Select Module popup.

**Task Type**

The type of tasks available to the particular user. The Activity task type allows the user to run the selected activity. The Administration task type allows the user to perform the selected administrative action. The Create task type allows the user to create a new record from a specified workflow. The Document task type allows the user to view the selected document. The Edit task type allows the user to edit records from a specified workflow. The Link task type allows the user to access the link. The Processing task type allows the user to run the selected process. The Table task type allows the user to maintain the selected table.

**Task Name**

The task name to add to the user’s list of tasks. This field is supported by a popup that is dependent on both the module and task type that has been selected. Activity tasks are supported by the Select Activity popup, Create and Edit tasks are supported by the Select Workflow popup, Administration tasks are supported by the Select Administration popup, Document tasks are supported by the Select Document popup, Processing tasks are supported by the Select Processing popup, and Table tasks are supported by the Select table popup.

**Note:** You cannot type a task name directly into this field; you must use the popup button to select the task. Link tasks are the exception for this rule. URLs are to be entered directly into the Task Name field.

**Display Name**

The name for this task that will be displayed within the Tasks pane. The Task Name is defaulted in this field and can be overridden.

**Button Functions**

**Properties:row**

Displays the Task Properties screen for the selected task. You can edit the properties that are allowed to be updated for that task.
User Setup

Multi-User Environment

People-Trak is a multi-user product. You can define almost any number of individual users, and they can access People-Trak simultaneously. It is very important that each user have a unique user ID.

By design, the System Administrator is the only person who should be performing User Setup. It provides access to all user profiles and has no internal security. If a user can access this menu item, the user can add, delete, and modify users at will.

User Types

The user type is assigned to a People-Trak user in User Setup and determines what People-Trak desktop and functionality is available to that user.

People-Trak supports the following user types:

- HR - HR User
- Employee - Employee Self-Service User (ESS)
- Manager - Manager Self-Service User (MSS)
- Ex-Employee - Ex Employee Self Service User (Ex-e)
- Applicant –Career Center User (CC)
- Visitor - Visitor User

The HR user type is the only one available in the base People-Trak Essential HR product. The Employee, Manager, and Ex-Employee user types are added when Self Service Employee/Manager has been implemented. The Applicant and Visitors are added with the implementation of Self Service Recruiting.

Key User Settings and Procedures

User Variables

The follow system variables are taken from the similarly-named fields that are maintained in the User Setup process. These variables reflect the currently logged in user. This is useful when the same form or letter is to be used by multiple users, but is to be signed by the user actually producing the report. The name of the user actually producing the particular letter is substituted into the letter.

- User Name
- User Phone
- User Extension
- User Fax
- User Signature
- User Email
- User Title
How to Add a New User

You can add a new user by entering all of the information from scratch or copying an existing user. Use the following procedure to add a new user from scratch:


   The User Setup screen is displayed.

2. On the File menu, select New User or on the Tool Bar, click the New User button.

   A new user is created with a temporary User ID of “NEW-” concatenated with the next sequential number available (for example, NEW-1, NEW-2, etc.).

3. Change the User ID of the new user to the correct User ID per your naming conventions.

   Typical user IDs are composed of the first letter of the user’s first name followed by their last name (but you may use any system that works for you).

4. Assign a Password to the new user.

   This can be a temporary password that they replace through Change Password once they have accessed People-Trak.

5. On the Identity tab, assign the correct Employee ID (if any) to this user.

   If an Employee ID is entered, the employee’s information is brought in from the employee record. If this user is not an employee, then the contact fields must be entered.

6. Enter any other settings as necessary for this new user.

7. Save this new user.

How to Copy a User

Use the following procedure to add a new user by copying another.


   The User Setup screen is displayed.

2. Highlight the user you want to copy.

3. On the File menu, select Copy User.

   A new user is created with a User ID of the original user concatenated with a dash and the next sequential number available. In addition, the settings for the original user are copied to the new user, except the Password field. In addition, the security settings (specified in Security Setup and Security Setup – Module) for the original user are copied to the new user.

4. Change the User ID of the new user to the correct User ID per your naming conventions.

   Typical user IDs are composed of the first letter of the user’s first name followed by their last name (but you may use any system that works for you).
5. Assign a **Password** to the new user.
   
   This can be a temporary password that they replace through Change Password once they have accessed People-Trak.

6. On the **Identity** tab, assign the correct **Employee ID** (if any) to this user.
   
   If an Employee ID is entered, the employee’s information is brought in from the employee record. If this user is not an employee, then the contact fields must be entered.

7. Enter any other settings as necessary for this new user.

8. Save this new user.

**How to Delete a User**

Use the following procedure to delete a user.

1. On the **Setup** menu, select **User Setup**.
   
   The User Setup screen is displayed.

2. Highlight the user you want to delete.

3. On the **File** menu, select **Delete User**.
   
   The user is deleted unless there are conditions under which the user cannot be deleted, of which you will be notified.

   **Note:** Delete users with caution. If the user being deleted is the owner of any documents that you want to keep, you will need to copy them to another user or to the COMMON user first.

**User Setup Screen**

The User Setup screen uses six tabs to record and maintain key user information, setups and defaults.

**Login Tab**

The Login tab is used to specify ID and status settings.

**User ID**

A unique phrase that identifies the user. Many organizations standardize user IDs in one of two formats. The first format is the first initial of the first name followed by the complete last name. For example: John Smith becomes "jsmith". The second format is the full first name followed by the first initial of the last name. For example: John Smith becomes "johns". Either format or any format you select will work up to the maximum of ten characters allowed.

   **Note:** Make certain that each user has a unique user ID. The user ID is used in naming temporary files. If users share an ID, the temporary files for the first user will be deleted when the second user signs in. This could cause a disruption in processing for the first user.

**Password**

A password that must be entered by the user to gain access to People-Trak. The password entered must meet the minimum length requirement as specified in the Minimum Length field in Enterprise Setup. If the Letters and Numbers check box is selected in Enterprise
Setup, the password must also contain a combination of letters and numbers.

Along with the user ID, the password forms a unique combination that grants access to People-Trak and determines which features will be available. The password entered with the User Setup process (selected from the Setup menu) can be changed by the user with the Change Password option (selected from the Tools menu).

When the password is typed in, asterisks are displayed for security purposes. In addition, the password is encrypted when stored in the database.

User Type

The user type of the user. In the base People-Trak Essential HR product, the only valid user type is HR, and this field is display only.

One thing the user type controls is when the User ID/Password combination is valid. For example, if the user type is HR, the User ID/Password combination is only valid when logging in as an HR user.

User Active

A check box that allows you to specify whether or not the user is active. Select the check box to make the user active. Clear the check box to make the user inactive. If the user is not active, he cannot log into People-Trak.

When a user is locked out because of exceeding the login attempt limit or grace logins (set in Enterprise Setup), the user is automatically set to inactive by clearing this check box. The System Administrator would have to select this check box for that user in order to give the user access to People-Trak again.

Last PW Change

The date of the last password change. This field is system maintained but can be manually changed if required.

Grace Logins Used

The number of grace logins used out of the number allowed. This field is display only and is system maintained. The number of grace logins allowed is set in the Grace Logins field in Enterprise Setup. Every time the user logs in without changing his password when a change is required, he will use one of his grace logins and this Grace Logins Used counter will be incremented. For example, if the Grace Logins count in Enterprise Setup is 3 and the user just used his first grace login, this counter will say “1 of 3”.

Password Question

The question to display when the Forgot your Password link is clicked on the Login screen after the User ID for this user has been entered.

Password Answer

The answer to the question entered in the Password Question field. If a user forgets his password, he must enter his User ID and then click the Forgot your Password link. The Password Question is displayed, and the user must enter the correct answer, as specified in this Password Answer field. When the correct answer is entered, the password for the user is mailed to the Email Address specified for the user here in User Setup.

Note: This answer is case sensitive, so how you enter it here is exactly how it must be entered when using the Forgot your Password link.
Preferences Tab
The Preference tab is used to specify user preference settings.

Scheme Name
The name of the color scheme to use for the user’s desktops and screens. This field is supported by the Select Color Scheme popup, which includes a list of color schemes. People-Trak is shipped with several color schemes, but you can define your own using the Maintain Color Schemes utility, which can be accessed by clicking the Define Colors button on this tab.

Default Company
The company to which the user is defaulted when logging in. The user can switch to any other company to which access has been granted after log in. This field should be set to the company that the user most frequently uses. This field is supported by the Select Company popup.

Default Module
The module to be made the current module when this user logs in. The user can switch to any other module to which access has been granted after login. This field should be set to the module that the user most frequently uses. This field is supported by the Select Module popup.

Alarm Frequency
The number of minutes between each check for alarms. The default setting for this field is 5 minutes. This means that alarms will be checked every 5 minutes. If you would like to increase this length of time for this user, you may choose to check alarms every 10, 30 or 60 minutes. There is also a 1 minute option, but this should be used only if absolutely necessary as it will slow system processing time.

The Alarm Frequency setting also controls how often the Inbox counter is refreshed. This counter shows how many items you have in your Inbox and is displayed below the Inbox icon on the Organizer Shortcut Bar. If the Alarm Frequency is set to 5 minutes, the Inbox counter will be updated every 5 minutes with the current number of items in your Inbox.

Lookup Limit
The number of records to show when a lookup is run. The default setting for this field is 0, which means that all qualifying records are to be shown. Changing this setting is only required if you have a very large number of records in the database, which would increase the time taken for a lookup. If you do choose a value for the Lookup Limit that is then less than the number of qualifying records in a lookup, the lookup results will state that the assigned record limit has been enforced. If you do not choose a value for the Lookup Limit and the number of qualifying records is greater than 5000, a Lookup Limit of 5000 is automatically enforced.

Enable Preselect
A check box that allows you to specify for this user whether or not an entry is pre-selected when the cursor is first positioned to a field. Windows normally pre-selects the entire entry. If you inadvertently press any key, the entire existing entry is replaced with that key. The People-Trak standard interface does not pre-select existing data, so this check box is cleared. If you would like the entire entry to be pre-selected, select this check box.

Inbox on Login
A check box that allows you to specify whether or not the Inbox will be displayed when the user logs in. Once you have closed the Inbox and moved deeper into People-Trak, the Inbox can be reactivated in the Organizer desktop with a single click on the Inbox icon on the Shortcut Bar or by selecting the Inbox option on the Tools menu. desktops, you can click
### User Setup

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run on Double-Click</td>
<td>A check box that allows you to specify which action to take when the user double-clicks on a document in the Explorer. If this option is checked, the document will run when you double-click on it. If this option is not checked, the appropriate document editor screen is opened when you double-click on a document.</td>
</tr>
<tr>
<td>Auto-Deliminate</td>
<td>A check box that allows you to specify whether or not you want date delimiters automatically entered for you when entering a date. If this check box is selected, only numbers can be entered in a date field and the delimiter specified in the PC’s regional date format setting is automatically entered in the correct positions. If this check box is not selected, numbers and a delimiter of “.”, “/” or “-” can be entered in a date field, and the field is formatted to the PC’s regional 10-character date format after it is entered. For example, if you type in “3.4.9” and press ENTER, the date will be formatted to 03-04-2009 if the PC’s date format is m-d-yyyy, mm-dd-yyyy or some variation of that.</td>
</tr>
<tr>
<td>Email Closing</td>
<td>The field used to specify the email closing template for an email. This closing is specified for the current user. This field is supported by the Email Closing Template. You can add this closing to the email text area by clicking the Add Closing button on the Send Email screen.</td>
</tr>
<tr>
<td>Button Functions</td>
<td></td>
</tr>
<tr>
<td>Copy from Desktop</td>
<td>Replaces the selected user’s tasks with the default tasks that were defined for their user type in Desktop Setup.</td>
</tr>
<tr>
<td>Define Colors</td>
<td>Allows you to maintain color schemes for individual HR users. When you click on this button, the Maintain Color Schemes utility is run, and the color scheme assigned to the user is automatically selected. The color schemes you maintain there are available for selection in the Scheme Name field.</td>
</tr>
<tr>
<td>Define Tasks</td>
<td>Displays the Desktop Tasks defined for the selected user. Tasks may be updated using the Copy from Desktop button or by manually entering tasks.</td>
</tr>
</tbody>
</table>

### Identity Tab

The Identity tab is used to specify the employee ID, contact information and digital signature.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee ID</td>
<td>The ID of the employee assigned as this user. It is possible to have users, such as consultants, that are not employees so this field would be left blank. This field is supported by a popup button that allows you to use the Lookup process to select the appropriate employee.</td>
</tr>
<tr>
<td>Note: The Full Name through Signature fields are display only if an Employee ID has been entered because these fields are brought in from the employee record.</td>
<td></td>
</tr>
<tr>
<td>Full Name</td>
<td>The formal full name of the user. This name can be substituted into documents and should be entered just as the user would sign a document.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of the user.</td>
</tr>
<tr>
<td>Telephone</td>
<td>The telephone number of the user.</td>
</tr>
<tr>
<td><strong>Extension</strong></td>
<td>The telephone extension of the user.</td>
</tr>
<tr>
<td><strong>Fax</strong></td>
<td>The fax number of the user.</td>
</tr>
<tr>
<td><strong>Email Address</strong></td>
<td>The email address for the user. This address is used throughout People-Trak to identify emails sent from this user and to send emails to this user.</td>
</tr>
<tr>
<td><strong>Signature</strong></td>
<td>The image to be used for this user’s digital signature. This field is supported by the Select Image popup so the appropriate image can be selected or an existing image can be cleared. This signature can then be merged into letters, labels or emails sent by the user. To clear the signature, use the Clear Image button, which is visible to the far right of the Signature field when in that field. The dimensions of this image are 200 pixels wide by 54 pixels high.</td>
</tr>
</tbody>
</table>

**Standard Workflows**

The Standard Workflows tab is used to specify for each user the screens to be displayed in each standard workflow and in what order.

Select the user and module for which you want to change the standard workflow. In the Screens frame, select the check boxes for screens to which you want the user to have access or clear the check boxes for screens to which you don’t want the user to have access. You can also click the Up and Down buttons to move screens to another location in the display order.

**Quick Search**

The Quick Search tab lists the modules the user has access to and specifies the Lookup Favorite to be used for each module when the Quick Search button is clicked by this user when looking up records.

| **Module** | The list of modules available to the particular user. This field is for display only. |
| **Quick Search Favorite** | The Quick Search Favorite field is used to specify the Lookup Favorite to be used when the Quick Search button is clicked by this user when looking up records. This button can be found and used on the Lookup for the module as well as the record manager activity. This field is supported by the Select Lookup Favorite popup. To create a favorite lookup, use the Lookup Favorite option on the Documents menu to create a document specifying the query to use for the record selection. |

**Note:** There can be an unlimited number of Lookup Favorites created in a module. It is best to assign a user’s most commonly used lookup favorite for Quick Search.
Lesson 1
Desktop Setup

Lesson Contents

Tutorial 1.1 – Specifying Login Settings 66
Tutorial 1.2 – Specifying Default Desktop Settings 68
Tutorial 1.3 – Specifying Logos and Header Settings 71
Tutorial 1.4 – Organizer Tab 74
Tutorial 1.5 – Specifying Default Desktop Tasks 75

This lesson covers how to specify the key settings in the Desktop Setup process.

Tutorials

Specifying Login Settings: shows how to change how the Login screen looks by changing the settings and images used by the Login screen.

Specifying Default Desktop Settings: shows how to change how the Login screen looks by customizing the color scheme used by the Login screen.

Specifying Logos and Header Settings: demonstrates how to determine what logo should display on documents as well as what should display in the header area of the Login screen and desktops.

Organizer Tab: specify which modules are accessible within the modules pane of the Organizer desktop

Specifying Default Desktop Tasks: shows how to assign the default desktop tasks for a user type.
Tutorial 1.1 – Specifying Login Settings

The Login Settings tab of the Desktop Setup process allows you to change how the Login screen looks by changing the settings and images used by the Login screen. Let’s take a look at each of these settings.

1. Start People-Trak by double-clicking on the People-Trak Trainee icon on your desktop (or as instructed).

   The Select Product Option screen is displayed. This screen is used for training purposes and allows you to set the product options applicable to your particular training session. All of the basic training classes use the base People-Trak product with only the Position Control and Attendance options selected. The Select Product Options screen toggles these options when the Training button is selected. Since most People-Trak customers have implemented the Position Control and Attendance options, training is normally performed with those options selected. If you are not currently using these options, you will learn about them and see some of their capabilities within the training courses.

2. The Position Control and Attendance options should be the only options that are toggled on. If not select the Training button to select them.

3. Click OK

   The Login screen is displayed.

4. In the User ID field, enter DEMO and press TAB or ENTER.

5. In the Password field, enter DEMO and press ENTER or click the OK button.

   The Organizer desktop is displayed with the Personnel Management module selected.


   The Desktop Setup screen is displayed with the Login Settings tab open.

7. In the Login Caption field, enter the caption you would like to have on the Login screen.

8. In the Login Welcome Text field, enter the text you would like to have in the welcome area of the Login screen.

9. Click in the Login Image field, and then click the Select Image popup button.

   The Select File screen is displayed.

10. In the PT9SAMPLES directory of your local People-Trak drive, select PETE WELCOME.JPG.

   This image will be displayed on the right side of the Login screen and should be sized to 260 pixels wide by 260 pixels high.

11. Click the Desktop tab.

   The Color Scheme field allows you to specify a color scheme to be used for the desktop
12. In the **Color Scheme** field, select the popup to display the **Select Color Scheme** screen.

13. Select **London Fog**, which is a gray scheme that will go nicely with the picture we are going to choose for the login image.

14. Close the **Desktop Setup** screen, saving your changes.

   We are ready to see how our changes affected the Login screen.

15. Click the **Logoff** shortcut on the Shortcut Bar.

   The Login screen is displayed using the London Fog color scheme and the Login Image you chose of Pete the People-Stik cruising on by. The Login Caption you entered is displayed as the caption. The Login Welcome Text is displayed as the welcome below the caption. We will learn about the heading settings for the Login screen in a future tutorial.

16. Log in as **DEMO/DEMO**.

   Notice that the desktop color scheme changed to the one assigned to the DEMO user, which is Charcoal Mint. The color scheme within Desktop Setup is only used for the Login screen, before the user is known. We will take a closer look at user desktop settings in User Setup.

17. On the **Setup** menu, elect the **Desktop Setup** menu option and return to the **Desktop** tab once again.

   We’re done playing with colors so let’s set the color scheme for the default desktop back to Charcoal Mint. Later training assumes that you have the data colors set to those in that scheme.

18. In the **Color Scheme** field, change the color scheme back to **Charcoal Mint**.

19. Stay on the **Desktop** tab and continue with the next tutorial.
Tutorial 1.2 – Specifying Default Desktop Settings

The Desktop tab of the Desktop Setup process allows you to determine default settings for the desktop that include overall settings such as alignment and colors and specifications for the web.

1. You should still be on the Desktop tab within Desktop Setup.

2. Click the Set Colors button, which is in the upper-right corner.

   The Color Schemes screen is displayed. You have automatically run the Maintain Color Schemes utility, which is also available from the Utilities menu. Charcoal Mint is highlighted in the list on the left, and the colors shown on the right are the ones assigned to that color scheme.

   The standard color schemes that are shipped with People-Trak cannot be changed. Since we want to play with some colors, we will first need to create a new color scheme in order to do so. We can either copy the current color scheme or create a new one that is based off the Classic Blue color scheme. Let’s use the copy feature so we can keep our cool mint colors and just change the data colors a bit.

3. On the File menu, select Copy Color Scheme.

   The current color scheme is copied to a new color scheme called Charcoal Mint-1.

4. Change the Scheme Code to My Color Scheme.

   First, let’s take a look at the frame and background colors.

   The fields in the Frame and Background Colors frame are currently using the colors assigned to the Charcoal Mint scheme: the Light Color is a pale mint color, Medium is a pale light green, and the Dark Color is an evergreen shade. Let’s spruce things up by picking some new colors.

5. In the Light Color field, click the popup button.

6. The Select Color popup is displayed.

   For the time being, we will stick with the eleven basic colors

7. Click on Yellow.

   The Light Color field is changed to the yellow color you chose

8. Click OK.

9. In the Medium Color field, click the popup button.

10. Click on Orange.

    The Medium Color field is changed to the orange color you chose

11. Click OK.

12. For the Dark Color field, repeat the same steps to select and change that color to Red.
13. Click the **Preview** button.

You can see what your current colors will look like in the preview screen on the right-hand side of the screen.

With the frame and background colors decided on, why don’t we take a look at data colors?

The fields in the Data Colors frame are currently using the data colors assigned to the Charcoal Mint scheme: Normal is Blue, Modified is Red, Mask is Yellow and Pending is Magenta. Let’s change some of them.

14. In the **Normal Color** field, click the popup button.

The Select Color popup is displayed. We can pick one of the eleven basic colors as we did earlier, or we can get creative and make a custom color. Let’s get creative!

15. Select **Custom**.

The Color screen is displayed with the current color (Blue) displayed in the Color|Solid area. This color just happens to be a basic color, so that square is highlighted in the Basic Colors. This shade of blue is also circled by dashes in the spectrum area and arrowed on the slider bar. The six color settings depict that color as well.

Choosing a color can be as simple as selecting from one of the 48 basic colors. Let’s do that for the Normal color.

16. Click on one of the **green** shades in the **Basic colors** section.

All of the settings on the right side of the screen are changed accordingly.

If you are really fond of a color and want to use it again, you can add it to the Custom Colors section.

17. Click the **Add to Custom Colors** button.

Your custom green color is added to the next available square in the Custom Colors section and can be easily selected in the future.

18. Click **OK** to select your custom color.

19. Select **OK** on the Select Color popup.

The Normal Color field is changed to the green color you chose.

20. In the **Modified Color** field, use what we have just learned to select a custom **blue** shade of your choice.

The Modified Color field is changed to the blue color you chose.

21. Click **OK**.

22. In the **Mask Color** field, select a **grey** shade using either color selection method.

23. Click **OK**.
24. Now try to change the **Modified Color** to the same color you used for the **Normal Color**.

You won’t be able to do so. This is because the Normal, Modified, Mask and Pending colors must all be unique. In your case the Normal Color is a certain shade of green, so the three other color fields cannot be that shade of green. In addition, the Normal, Modified and Pending colors cannot be white because the background color on text boxes is white and the white text would be completely lost in the white background. All four colors should also be noticeably different from the gray color that is used for display only.

The Pending Color field is used when approvals are being used. We won’t take time to demonstrate that, but the color is changed just like the other data colors.

25. Click the **Preview** button to see what your data colors will end up looking like in action.

Let’s give our minds and eyes a well deserved break and move on. We won’t be changing any other colors in this demonstration.

26. Close the **Color Schemes** screen, saving your changes.

Before leaving the Desktop tab, let’s make sure that we change the color scheme to something other than the mess of colors we have just created.

27. In the **Color Scheme** field, select **London Fog** as the new default desktop color.

28. Close the **Desktop Setup** screen saving your changes.

You may notice that our desktop colors have not changed. While we did change the default desktop settings for the HR user type, we still need to update these settings for our individual users. We will have the opportunity to do this in a future lesson when we learn about User Setup. Before we do that, we have a few more important areas to cover within Desktop Setup.

29. Continue with the next tutorial.
Tutorial 1.3 – Specifying Logos and Header Settings

The Logos and Header tab of the Desktop Setup process allows you to determine what logo should display on documents as well as what should display in the header area of the Login screen and desktops.

1. On the Setup menu, select Desktop Setup.

2. Click the Logos and Header tab.
   
   The Document and Heading Logo fields allow you to select what logos you would like to use when the enterprise header is being used. You select these like you saw earlier in the Company Setup training. Since we want to demonstrate how the header text settings work in this tutorial, we will need to change our Heading Logo to be one that does not already include text.

3. In the Heading Logo field, click the leftmost popup button to select the image. In the PT9SAMPLES directory of your local People-Trak drive, select ZTI_BANNER_NO_TEXT.JPG.

4. Click on the Enterprise Header Only check box to select it.
   
   By selecting the Enterprise Header Only check box, we will set all desktop headers and as well as the header on the login screen to the Heading logo that we just selected in Desktop Setup.

5. Double click on the Include Header Text check box to select it.
   
   The Include Header Text check box allows you to include the heading text in the enterprise header. You would want to clear this check box if your enterprise heading logo has the heading text already in it. This was the case with our original logo, however, as we mentioned earlier, our new Heading Logo does not.

   The Header Text Alignment field allows you to choose how you want the heading text aligned. This field is only used when the Include Header Text check box is selected.

6. Leave the Header Text Alignment set to Right.

   The last four settings allow you to specify the font and color to use for the text.

7. In the Name field, use the popup to select whatever font settings you want.

8. In the Color field, choose your favorite color.
   
   Let’s see how the settings you just made affect the headers on the Login screen and desktops.


10. Click the Logoff shortcut on the Shortcut Bar.

    The Login screen is displayed with the header including the enterprise heading logo on the left and the enterprise name justified to the right, using your font and color choices.
11. Log in as **DEMO / DEMO**.

   The Organizer desktop is displayed. Since you chose to use the enterprise header only, the enterprise header is displayed here just like on the Login screen.

   Let’s show you what a short logo looks like in the heading. We will change our company header to use that and then switch back to using company headers again.

12. On the **Setup** menu, select **Desktop Setup**.

13. Click the **Logos and Header** tab.

14. In the **Heading Logo** field, select **ZTI_ACTIVE_SHORT_LOGO.JPG** from the **PT9SAMPLES** directory of your local People-Trak drive.

15. Close **Desktop Setup**, saving your changes.

   The heading has changed to display the current company’s short logo but the company name is not displaying. This is because the image we used is not wide enough to have the company name text overlaid upon it. The image must be as wide as what you want to display in the heading. We recommend that all Heading Logo images be sized to 1040 pixels wide by 74 pixels high, which matches the size of the heading area of the desktop. Let’s pick an image that has the correct dimensions.

16. On the **Setup** menu, select **Desktop Setup**.

17. Click the **Logos and Header** tab.

18. In the **Heading Logo** field, select **ZTI_ACTIVE_BANNER_NO_TEXT.JPG** from the **PT9SAMPLES** directory of your local People-Trak drive.

   This logo looks just like the Document Logo but is in fact wider using white space to extend the image.

19. Clear the **Enterprise Header Only** check box.

   Company headers will now print on the desktops.

20. In the **Header Text Alignment** field, enter **Left**.

21. Close the **Desktop Setup** screen, saving your changes.

   This time the heading displays both the logo and the name. Note that the name is left justified in the area available for the heading text. As you can see, Desktop Setup controls the text alignment for both the enterprise and company headers.

22. Click the **Logoff** shortcut on the Shortcut Bar.

   The Login screen is displayed and now includes the enterprise logo with the name left justified this time. The enterprise header always prints on the Login screen, unless you are using custom headers and footers, which is available on the Web.

23. Log in as **DEMO / DEMO**.
The Organizer desktop is displayed. The header area contains the company logo and name.

Let’s return our desktop and login header settings back to where they were when we first started.


25. Click the Logos and Header tab.

26. In the Heading Logo field, select ZTI_BANNER_HR.JPG from the PT9\SAMPLES directory of your local People-Trak drive.

27. Clear the Include Header Text check box.

28. Close Desktop Setup, saving your changes

The company header (and the enterprise header, which you can’t see yet) is now back to the way it was when we started.

As you have seen, the headings on the Login screen and desktops can be customized to exactly what you desire.

29. Continue with the next tutorial.
**Tutorial 1.4 – Organizer Tab**

The Organizer tab is used to specify which modules are accessible within the Modules pane of the Organizer desktop. In this tutorial you will learn how to adjust these settings according to your desktop preferences.

1. On the Organizer desktop, take a look at the modules listed in the Modules pane.
   
   Of all the modules we have access to; perhaps we aren’t utilizing Contact Management at this point in time. And by removing it from the Modules pane, it is one less

2. On the Setup menu, select Desktop Setup.

3. Click the Organizer tab.
   
   A list of the available modules is displayed. Each module has a checkbox that has been selected. But not for long.

4. Select the Contact Management module and clear its check box.

5. Close the Desktop Setup screen, saving your changes.
   
   The Contact Management module is no longer in the Modules pane of the Organizer desktop.
   
   Multiple modules can be removed using the same steps.


7. Click the Organizer tab.

8. Clear the checkboxes for the remaining modules except for Personnel Management.

   
   Personnel Management is the only module within the Modules pane. This change is extreme, but luckily it is only temporary.


11. Click the Organizer tab.
   
   Re select all cleared checkboxes to activate the modules once again.

12. Close the Desktop Setup screen, saving your changes.
   
   The modules have been returned to the Modules pane and it is as if nothing ever happened.

13. Continue with the next tutorial.
Tutorial 1.5 – Specifying Default Desktop Tasks

In this tutorial, you will learn how to assign default desktop tasks to a user type, which will then be used to populate and update Desktop Tasks within User Setup.

1. On the Setup menu, select Desktop Setup.

2. Click the Tasks tab.
   
   Let’s start fresh by deleting all the existing tasks.

3. On the Tool Bar, select the Delete Row button to delete all the existing tasks.
   
   You have a choice of having tasks for a user organized by groups. Group names can be anything you want. If you do choose to use groups, it is important that all tasks for each group be kept together in the tasks grid.
   
   Our training database uses the group option, so we’ll add our new tasks to a group as well.

4. In the Group column of the first blank row, enter My HR Activities.

5. As you leave the field, the following message is displayed:
   
   Entry is not in the table, Override Table?

6. Click Yes.

7. In the Module column, click the popup button.
   
   The Select Module popup is displayed with a list of the modules that this user has access to.

8. Select the Personnel Management module and select OK.

9. In the Task Type column, click the popup button.
   
   The Select Task Type popup is displayed with a list of the task types that this user has access to.

10. Select the Activity task type and select OK.

11. Try entering a task name directly into the Task Name field. You cannot.
   
   Because of the complexity of this selection process, you must use the popup button to select a task.

12. In the Task Name column, click the popup button.
   
   Since we selected Activity for our task type the Select Activity popup is displayed with a list of the activities within the Personnel module that this user has access to.

13. Select the Employee Manager activity.
   
   The Display Name field for this task is defaulted to the Task Name but can be changed.
We can use the same methods to add a few more tasks to our task list.

14. Select the **Save** icon.

15. In the **Group** column of the second blank row, enter **My HR Workflows**.

16. As you leave the field, the following message is displayed:

   **Entry is not in the table, Override Table?**

17. Click **Yes**.

18. Select the **Personnel Management** module and add a **Create** task that uses the **Standard-Employee** workflow.

19. Select the **Save** icon and move to the next blank row.

20. In the **Group** column, select the popup button.

   Remember the two tasks we just saved? By saving those tasks, we were able to store the group names in a table. For future tasks that may be in the same group, we can simply select the group name from this table instead of rekeying it.

21. Select the **My HR Workflows** group.

22. For this task, select the **Safety Management** module and add an **Edit** task that uses the **Standard-Incident** workflow.

23. In the next row, select the **Benefit Administration** module and add a **Document** task type.

24. Use the **Select Document** popup to select the **Benefit Plan Enrollment by Employee** report from the **Benefit** category in **Adhoc Reports**.

25. In the next row, select the **Safety Management** module and add a **Processing** task type.

26. Use the **Select Processing** popup to select the **Claim Cost Batch**.

   For our final task, we are going to add a link, which is done a bit differently than our other tasks. First of all, we don’t need to specify a module; however, we do need to select what type of task we are adding.

27. In the **Task Type** field, use the popup to select the **Link** task type.

28. Select **OK** to return to the **Tasks** tab.

29. In the **Task Name** field enter **www.shrm.org**.

   The Display Name is defaulted to the URL, but as we mentioned, this can be changed.

30. In the **Display Name** column, enter the following:

   **SHRM Home Page**

31. Close the **Desktop Setup** screen, saving your changes.
We will be taking a closer look at how the default desktop tasks are updated for individual users in an upcoming tutorial.

32. This concludes this tutorial and lesson.
Lesson 2
User Setup

Lesson Contents

Tutorial 2.1 – Adding/Deleting Users 80
Tutorial 2.2 – Setting User Preferences 82
Tutorial 2.3 – Changing Default Settings at the User Level 84
Tutorial 2.4 – Changing Standard Workflows 86

This lesson covers the key settings in the User Setup process.

Tutorials

Adding/Deleting Users: demonstrates how to add and delete users.

Setting User Preferences: shows how set the preferences for individual users.

Changing Default Settings at the User Level: demonstrates how modify the default preferences for individual users.

Changing Standard Workflows: demonstrates how to change the standard workflows for a user.
Tutorial 2.1 – Adding/Deleting Users

This tutorial describes how to add and delete users.

1. On the **Setup** menu, select **User Setup**.

   When you first enter the User Setup screen, the user ID you used to access People-Trak (DEMO in this case) becomes the current user record being edited. You can use the list of users to select any other user for editing.

2. On the **File** menu, select **New User** or on the Tool Bar, click the **New User** button to add a new user.

   A new user is created with a temporary User ID of “NEW-” concatenated with the next sequential number available. In our case, that User ID is NEW-1 since that code did not exist yet. As you can see, this is the same naming scheme that was used when we added a new company.

   Your new user is now your current user for editing purposes. At this point you would enter all the information for this new user, but let’s demonstrate the Copy User feature to see how this can save you some time if you have an existing user that is similar to the new user you want to create. This is very similar to the Copy Company feature you learned about in the last lesson. Let’s assume the user that is similar to the one we want to create is the DEMO user.

3. Highlight the **DEMO** user.

4. On the **File** menu, select **Copy User**.

   A new user is created with a User ID of DEMO-1, which is the User ID of the user you copied concatenated with a dash and the next sequential number available. In addition, the settings for the DEMO user are copied to the new user, except the Password field.

   You can look at the other tabs if you wish to verify this. In addition, the security settings (specified in Security Setup and Security Setup – Module) for DEMO are copied to the new user.

5. Change the **User ID** of the new user from **DEMO-1** to **JSMITH**.

   Normally, you would enter the correct user ID per your naming conventions. Typical user IDs are composed of the first letter of the user’s first name followed by their last name (but you may use any system that works for you).

6. Assign a **Password** to the new user.

   This can be a temporary password that the user can replace using the Change Password process once he or she has accessed People-Trak. As you type in the password, asterisks are displayed for security purposes. In addition, the password is encrypted when stored in the database.

7. Select the **Preferences** tab.

   The Default Company and Default Module fields are the same as the DEMO user you copied. We will leave these fields as is.

8. Click the **Identity** tab.
9. In the **Employee ID** field, click the popup button.
   
   The Lookup screen is displayed.

10. Click **Search** and then highlight any employee. Click **OK**.

    Note that the Full Name through Digital Signature fields have had information brought in from the Employee record and are display only.

    If you have users that are not employees, such as consultants, you would leave the Employee ID field blank, and enter the following fields manually.

11. Click the **Standard Workflows** tab.

    The DEMO user currently has the standard workflows for each module set up in the same way that the standard workflows are shipped, with all screens on and in that same order. We will take a closer look at this tab in an upcoming tutorial.

12. Click the **Quick Search** tab

    The DEMO user did not have a Quick Search Favorite assigned for any of the modules, so the new user does not have any either.

    We have seen how the addition of a new user is accomplished. Now, let’s delete this user.

13. On the **File** menu, select **Delete User** or on the Tool Bar, click the **Delete User** button to delete the user. You will be asked to confirm the deletion. Go ahead and delete the user. We will leave **NEW-1** user alone for now, as we will be using them in an upcoming tutorial.

    **Note:** In a live environment, you will want to delete users with caution because documents owned by those users are also deleted. If the user you want to delete is the owner of any documents that you want to keep, you will need to copy those documents to another user or to the COMMON user first.

14. Continue with the next tutorial.
## Tutorial 2.2 – Setting User Preferences

In this lesson, we will take a look at just a few of the user preferences that can be specified on the Preferences tab of User Setup.

1. You should still be in the **User Setup** screen. Select the **DEMO** user.

2. Select the **Preferences** tab.

   The Enable Preselect check box field determines whether text boxes (stand alone and in grids) are to be treated in the Windows way or in the People-Trak way. At this point, the check box should not be selected.

3. Move the cursor around and note that with preselect not enabled, the entry in the field is not pre-selected.

4. Change the interface to the Windows standard by selecting the **Enable Preselect** check box.

   In order to see this change take effect, you must close User Setup and save your changes.

5. Close the **User Setup** screen, saving your changes. Select **User Setup** option again.

6. Now, move the cursor from field to field, and you will see that the contents of each field are pre-selected.

   If you touch a key when the contents are pre-selected, the contents are replaced with the key you pressed. This scares people and is why People-Trak is shipped with preselect disabled. It is a better way to meet the heavy data entry requirements of a personnel management product.

7. Clear the **Enable Preselect** check box.

   Now, on to the Auto-Delimit feature. People-Trak is shipped with the Auto-Delimit feature turned on, which automatically puts the appropriate delimiter (from your PC’s regional format settings for dates) in dates for you; all you need to do is type the numbers. If you prefer to type in your own delimiters, you can turn this feature off. You have already seen the delimiters put in for you in the Intro to PT training, so let’s turn off this feature and see how that works.

8. Clear the **Auto-Delimit** check box.

   We can use the Last PW Change date field on this screen to demonstrate this setting, but we need to close the screen and come back into it in order for the setting change to take effect.

9. Close the **User Setup** screen, saving your changes.

10. Select the **User Setup** option again and stay in the **Login** tab area.

11. Clear the **Last PW Change** field and then type **119** and press **ENTER**.

    No delimiters are automatically placed for you, and you receive an invalid date message.
12. Clear the **Last PW Change** field and then type **1.1.9** and press **ENTER**.

   The date is formatted according to your PC’s regional format settings for dates. Our date examples assume a “m-d-yyyy” setting so “01-01-2009” is displayed. Note that you did not have to put in “01-01-2009” but could use date “shorthand”. You can use the “.”, “-” or “/” delimiters when you type in a date and upon pressing ENTER, the date will be formatted according to your PC’s regional 10-character date format after it is entered.

   Let’s turn the Auto-Delim feature back on before we head to the next tutorial.

13. Switch to the **Preferences** tab

14. Select the **Auto-Delim** check box and stay in the **User Setup** screen.

15. Continue with the next tutorial.
Tutorial 2.3 – Changing Default Settings at the User Level

In a prior lesson, we defined the default desktop colors and tasks for our HR users. Within this tutorial, we will be learning how these default settings can be changed for individual users.

1. You should still be in the User Setup screen on the Preferences tab.

2. Select the NEW-1 user.

   Notice that the scheme name for our NEW-1 user has been set to London Fog, the default that we recently changed in Desktop Setup. Every time a new user is created, they are assigned the default color scheme.

   You may recall that we defined default desktop tasks as well. When the NEW-1 user was created, they automatically inherited those tasks. We check on that now.

3. Select the Define Tasks button.

   The Desktop Tasks screen is displayed along with the tasks we defined.


   Our newest user is up to date with the defaults. For our existing users, however, we may need to do some housekeeping.

5. Select the DEMO user.

   The color scheme is still set to Charcoal Mint which is not the default.

6. Select the Define Tasks button.

   The tasks haven’t been updated to the defaults either.

   Let’s synch the DEMO user with Desktop Setup.

7. Close the Desktop Tasks screen.

8. Select the Copy from Desktop button.

   The DEMO user’s color scheme has changed to London Fog. We still need to take a look at their desktop tasks.

9. Select the Define Tasks button.

   The Desktop Tasks screen is displayed with the updated set of tasks. A successful synchronization has occurred!


    Some users may not prefer having default settings assigned, and may request color schemes and task based on their individual preferences. User settings can be easily changed as we will find out with the DEMO user.

    First, let’s change the default desktop colors for the DEMO user.
11. In the **Scheme Name** field, select the **Charcoal Mint** color scheme.

   And with that, the desktop colors are changed. If the DEMO user was a bit pickier about colors, we could modify this color scheme like we did in Desktop Setup. But for now, this color scheme is perfect.

   Now we can move on to modifying the DEMO user’s tasks.

12. Select the **Define Tasks** button to display the **Desktop Tasks** screen.

13. Highlight the task in the first row.

14. On the **Tool Bar**, select the **Insert Row** button to add a new blank row.

   Let’s add an administrative task that will only be for our DEMO user.

15. In the **Module** column, use the popup to select the **Personnel Management** module.

16. In the **Task Type** column, use the popup to select the **Administration** task type.

17. In the **Task Name** column, use the popup to select the **Adhoc Reports** task.

18. Click the **Save** button to save all of these changes.

   The DEMO user now has the ability to run, create, and maintain adhoc reports from their list of tasks. They have been uniquely set apart from the other users who have only been given the default desktop tasks.

   Speaking of being unique, users may also have a set of tasks that is specific to them. We will take a look at how this is done, once again with our DEMO user.

19. Highlight the task in the first row, which should be the newly added administration task.

20. On the **Tool Bar**, select the **Delete Row** button to delete all the existing rows.

21. Leave the **Group** column blank and add three different activity tasks from the COBRA Administration module.

   There you have it! Changing and updating tasks on a user level is as simple as that.

22. Close the **Desktop Tasks** screen, saving your changes.

23. Close the **User Setup** screen, saving your changes.

   Since future lessons assume that we are using the Charcoal Mint color scheme, we should change our default desktop settings back to reflect this.

24. On the **Setup** menu select **Desktop Setup**.

25. On the **Desktop** tab, use the popup in the **Scheme Name** field to select the **Charcoal Mint** color scheme.

26. Close the **Desktop Setup** screen, saving your changes.

27. Continue with the next tutorial.
Lesson 2

Tutorial 2.4 – Changing Standard Workflows

People-Trak is shipped with a standard workflow for each module. The naming convention is “Standard - Record”, where Record is the name of the record maintained by that module. For example, the Personnel Management module maintains the Employee record, so the workflow for that module is “Standard-Employee”. Each user can have his own version of the standard workflow. Let’s see how to do this.

1. On the Setup menu, select User Setup

2. Click the Standard Workflows tab.

The first module in the Modules pane, Personnel Management, is selected. All of the screens in the Screens pane are selected. The DEMO user is defaulted to having all of the standard workflows be the same as what is shipped with People-Trak. So, what you are seeing as the order in the Screens pane is the same as the shipped Standard - Employee workflow for the Personnel Management module.


The Screens pane now displays the screens for the Standard - Incident workflow for the Safety Management module. Let’s go back and change the Standard - Employee workflow for the Personnel Management module.


To remove a screen from being displayed in a workflow, just clear the check box for that screen.

5. In the Screens pane, click Status, which will highlight that check box. Click Status again, which will clear that screen’s check box.

You can also change the order of the screens.

6. In the Screens pane, click Compensation, and then click the Up button twice to move the Compensation screen up to the top of the Screens pane.

The Compensation screen is now our first screen and the Status screen will no longer be displayed.

7. Close the User Setup screen, saving your changes.

8. Click the Open Employee shortcut on the Shortcut Bar and select any employee.

As you specified, the Compensation screen is the first screen displayed.

9. Click the Screen dropdown button.

You can see that the Personal screen is next in the list and there is no Status screen after that. We have changed the standard workflow, but only for this user.

10. Close the dropdown, and close the employee.

    Let’s change the DEMO user’s Standard - Employee workflow back to the way it was.

12. On the Standard Workflows tab, move the Compensation screen back down to being third in the list of screens. Select the Status screen’s check box so it will be included once again.

13. Close the User Setup screen, saving your changes.


15. This concludes this tutorial and lesson.